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ВВЕДЕНИЕ 
 

Учебный практикум предназначен для студентов, осваивающих 
графические  системы и технологии , методы и способы создания хранением 
и обработкой моделей объектов и их изображений с помощью ЭВМ [1].  

Система AutoCAD, созданная фирмой «Autodesk», является на 
сегодняшний день наиболее распространенной программной графической 
системой автоматизированного проектирования в промышленности. Сама 
фирма «Autodesk» занимает четвертое место в мировом «табеле о рангах» 
среди разработчиков программного обеспечения для персональных 
компьютеров. Согласно «Autodesk», общепринятое в мире персональных 
компьютеров сокращение CAD означает как систему конструирования с 
помощью компьютера (Computer Aided Design), так и систему технического 
черчения с помощью компьютера (Computer Aided Drafting and Drawing). В 
отечественной литературе подобные системы известны как системы 
автоматизированного проектирования – САПР. 

Первая версия AutoCAD увидела свет в 1982 году и работала всреде 
DOS. Успех системы AutoCAD во многом объяснялся принятой при ее 
разработке концепцией системы с открытой архитектурой. Главная ее 
особенность состояла в том, что файлы были представлены в формате ASCII. 
Это позволяло легко использовать содержащиеся в них данные в 
сопряженных пользовательских системах. Другим важным фактором была 
предусмотренная в системе возможность использования 
специализированного языка программирования Auto-LISP. 

AutoCAD является базовой системой для целого ряда более 
специализированных САПР, используемых в различных областях науки 
техники: в архитектуре, машиностроении, географических информационных 
системах, автоматизированных системах управления ресурсами, 
электротехнике и электронике, системах мультимедиа. В настоящее время 
AutoCAD является постоянно развивающейся средой проектирования. Версия 
– AutoCAD 2010 - на сегодняшний день самая распространенная в мире 
система автоматизированного проектирования из тех, что разработаны для 
персональных компьютеров Автокад 2010 позволяет значительно снизить 
затраты времени благодаря параметрическим чертежам. Параметрические 
чертежи позволяют сокращать время проверок проектов. В автокаде 2010 
предусмотрена возможность задания зависимостей между объектами. Так, к 
примеру, параллельные линии в автоматическом режиме остаются 



параллельными, а концентрические окружности всегда будут иметь общий 
центр. Автокад 2010 представляет небывалую свободу творчества, позволяя 
работать с произвольными формами. Теперь имеется возможность воплощать 
любые идеи и цели проекта, дав волю фантазии и творческой мысли. Для 
создания сложных форм необходимо просто осуществлять перемещения 
граней, ребер, вершин. 

Он обладает улучшенной поддержкой формата PDF. Так, теперь 
возможности передачи и повторного использования данных стали еще 
намного более удобными и легкими благодаря внедрению нового уровня 
поддержки формата PDF. Размер публикуемых файлов значительно 
уменьшился наряду с увеличением количества сохраняемой полезной 
информации, внедрена поддержка шрифтов формата TrueType. Благодаря 
новым возможностям импорта в Автокад 2010 появилась возможность 
добавлять файлы формата PDF непосредственно в чертежи Автокада. 

Трехмерная печать моделей Автокад 2010. Теперь возможно не просто 
визуализировать проекты, но и воплощать их в реальность благодаря 
значительно переработанной и обновленной системе визуализации. 
Появилась возможность создания физических макетов проектов путем 
вывода их на трехмерный принтер. 

В этой программе значительно переработана система создания и 
редактирования динамических блоков. Внедренные новшества и улучшения 
помогают упростить процесс создания и редактирования динамических 
блоков. Благодаря усовершенствованной системе отображения и выделений 
объектов, инструменты для работы с динамическими блоками существенно 
снижают временные затраты на выпуск сопроводительной документации. 

С помощью обновленной утилиты – Автокад Импрешн - появилась 
возможность создания презентационной графики. Еще одна утилита - 
Autodesk Design Review 2010 – позволяет провести ускоренную проверку 
проектов  Автокад. 

Практикум  состоит из практических работ, которые могут быть 
выполнены под руководством преподавателя или самостоятельно 
(дистанционная форма обучения). Каждая работа включает в себя описание 
изучаемых команд и понятий; упражнения, которые необходимо выполнить в 
интерактивном диалоге с системой; практическое задание. Для самоконтроля 
приводятся вопросы. 

Некоторые соглашения, принятые в тексте практикума. Чертить 
(вводить в чертеж графические элементы) в системе можно при помощи 
мыши. Мышь на экране управляет графическим символом –указателем, вид 
которого зависит от выполняемой операции. Данное пособие ориентировано 



на использование двухкнопочной мыши. Левая кнопка является кнопкой 
выбора. Пользуясь ею, можно выбирать пункты меню, пиктограммы панелей 
инструментов и задавать (указывать) точки при построении графических 
элементов чертежа. Если в тексте сказано: «Выберите View→ Toolbars», 
«Щелкните на пиктограмме Line панели инструментов Draw», «Укажите 
окружность на чертеже», то все эти операции следует выполнять, пользуясь 
левой кнопкой мыши. Если вы встретите в тексте выражение «Нажмите 
Enter» или «Enter», то это означает, что нужно нажать на клавиатуре 
клавишу Enter. В большинстве случаев клавиша Enter дублируется правой 
кнопкой мыши. 

Основные действия с мышью приведены в таблице ниже. 
 

 
Действие Описание действия 

Щелкнуть Быстро нажать и отпустить кнопку 
мыши. Если особо не оговорено – это левая 
кнопка 

Указать Подвести курсор к графическому 
объекту и щелкнуть левой кнопкой мыши. 

Дважды  
щелкнуть 

Быстро выполнить два щелчка. 
Интервал между щелчками должен быть как 
можно короче. 

Протянуть Перемешать курсор, за которым будет 
следовать некоторый графический объект. 

Выбрать Подвести курсор и щелкнуть на пункте 
меню, пиктограмме панели инструментов, 
элементе диалогового окно или графическом 
объекте. 

 
Команды интерфейса, которые формируются в процессе обращения к 

меню и панелям инструментов системы, в тексте выделены курсивом. Фраза 
«Выберите View→ Toolbars» означает, что нужно сначала щелкнуть на 
пункте главного меню (View), а потом в открывшемся меню выбрать пункт 
Toolbars. Запросы и приглашения также выделены в тексте курсивом. 

Сохранение файла чертежа AutoCAD ничем не отличается от 
сохранения любого другого файла Windows. Сделайте правилом сохранять 



файл текущего чертежа каждые 10 - 15 минут. Это избавит вас от потери 
информации при возможных непредвиденных ситуациях, в частности при 
сбое питания. Для того чтобы сохранить созданный чертеж, выберите в меню 
File (Файл) пункт Save As (Сохранить как). 

На экране появится диалоговое окно Save Drawing As (Cохранить 
рисунок как). Выберите папку, в которой вы будете сохранять свои чертежи. 
Активизируйте поле File Name (Имя файла), введите в него имя файла и 
щелкните на кнопке Save (Сохранить). 
 



 

ЧАСТЬ 1. ДВУХМЕРНОЕ МОДЕЛИРОВАНИЕ 

Практическая работа № 1 

 
ПЕРВОЕ ЗНАКОМСТВО С AUTOCAD 2010 

 

Цель занятия 

 

Знакомство с принципами работы AutoCAD 2010, основными приемами 
использования меню, командной строки, панели инструментов, строки 
состояния. Выполнение упражнений по использованию основных команд 

AutoCAD: Circle, Line, Offset, Mirror, Trim, Erase. Изучение базовых 
технологий построения и редактирования рисунков в AutoCAD. 

 

.Порядок выполнения 

 

Практическая работа заключается в последовательной реализации 

нижеследующего интерактивного диалога с системой автоматизированного 
проектирования AutoCAD 2010. 

 

Запуск AutoCAD в операционной среде Windows 

В практикуме мы рассматриваем новую версию AutoCAD 2002, ту ее 
модификацию, которая работает под управлением операционной системы, 
Windows 2000 / XP / Vista / 7, Mac OS X.  

После включения компьютера Windows загружается автоматически, и на 
экране появляется Рабочий стол. Windows предлагает пользователю 
несколько способов запуска программы, простейшим из которых является 
двойной щелчок мыши на соответствующем ярлыке. 



 

Если ярлык отсутствует, то предлагается следующая последовательность 
операций: 

- щелкните на кнопке Пуск на панели задач в нижней части экрана; 

- выберите пункт Программы; 

- в открывшемся списке выберите AutoCAD 2010. Откроется подменю, и в 
нем нужно выбрать AutoCAD.  

На экране можно выделить четыре функциональные зоны (рис. 1). 

Графическая зона. Это большая пустая зона в середине экрана. Именно в ней 
вы будете выполнять элементы чертежа. Эта зона может иметь произвольные 
размеры. Она снабжена несколькими вкладками. Во вкладке Model 
отображена часть чертежа, которая называется пространством модели.  

В каждой из оставшихся вкладок отображена отдельная компоновка 
пространства листа. 

 

 
                                              Рис. 1 

 



 

    Центральная область рабочего окна программы называется 
графическим экраном. В ней выполняются все построения. На графическом 
экране указатель мыши приобретает вид перекрестья и способен выполнять 
функции, используемые в проектировании: привязку к объектам, задание 
координат и направления. При выходе за границы графического экрана 
указатель приобретает привычный вид. 

    В верхней части окна находится лента с вкладками, на которых 
расположены кнопки команд Она заменила пункты меню, используемые в 
предыдущих версиях программы. Для пользователей, предпочитающих 
прежний вид окна, предусмотрена возможность переключения в режим, 
называемый классическим. Познакомимся с ним подробнее. Строка меню 
включает в себя множество пунктов для вызова различных команд и 
открытия диалоговых окон.  

    • File (Файл). Здесь находятся команды обработки файлов: создания, 
сохранения, восстановления. Кроме того, это меню содержит команды, 
используемые для печати документов. 

    • Edit (Правка). Пункты данного меню позволяют выполнять 
стандартные для Windows операции работы с буфером обмена (вырезать, 
скопировать, вставить), а также команды специальной вставки, удаления, 
выделения и поиска. 

    • View (Вид). С помощью команд данного меню вы можете управлять 
отображением объектов на экране. Здесь расположены такие подменю, как 
Zoom (Масштабирование), Pan (Панорамирование) и др. В этом же меню 
находятся команды регенерации чертежей. Кроме того, меню View (Вид) 
содержит команду Toolbars (Панели инструментов), при выборе которой на 
экране отображается диалоговое окно Customize User Interface (Настройка 
интерфейса пользователя). С помощью данного окна вы сможете создавать 
собственные меню, панели инструментов, назначать сочетания клавиш для 
быстрого вызова команд и окон, а также редактировать имеющиеся. Более 
подробно об этом диалоговом окне будет рассказано ниже. 

    • Insert (Вставка). Команды этого меню позволяют вставлять в поле 
чертежа блоки и объекты, созданные ранее в сторонних приложениях, а 
также импортировать в AutoCAD различные файлы. 

    • Format (Формат). Данное меню предназначено для вызова 
диалоговых окон, помогающих определить множество параметров черчения. 
Последняя команда – Rename (Переименовать) – служит для переименования 
различных объектов программы, таких как слои, материалы, блоки и др. 

    • Tools (Сервис). Здесь вы можете изменять различные настройки 
программы, вызывать на экран вспомогательные окна, а также загружать 



 

внешние приложения и управлять ими. В этом же меню находится группа 
команд для работы с макросами, создаваемыми на языке программирования 
VBA. 
    Подменю Workspaces (Рабочие пространства) предоставляет доступ к 
рабочим пространствам программы. Оно служит для переключения между 
пространствами, а также для их настройки и сохранения. 

    Палитры программы сгруппированы в отдельное подменю – Palettes 
(Палитры). Рассмотрим его содержимое. 

    · Ribbon (Лента) – включает отображение ленты с инструментами. 
    · Properties (Свойства) – открывает палитру, позволяющую 

управлять свойствами объектов. 
    · Layer (Слой) – вызывает палитру, содержащую команды для работы 

со слоями. 
    · Tool Palettes (Инструментальные палитры) – открывает палитру, 

содержащую различные инструменты, такие как блоки, образцы штриховок и 
т. д., в одном окне для упрощения доступа к ним. 

    · QuickCalc (Быстрый подсчет) – вызывает палитру, позволяющую 
выполнить различные вычисления (эту палитру можно также вызвать 
сочетанием клавиш Ctrl+8). 

· External References (Внешние связи) – открывает палитру, которая 
дает возможность управлять связями с другими файлами чертежей. 

    · Sheet Set Manager (Менеджер подшивок) – вызывает палитру, 
служащую для публикации подшивок листов, групп листов или отдельных 
листов. 
    · Markup Set Manager (Менеджер пометок) – открывает палитру, которая 
позволяет управлять пометками, добавленными к документу. 

    · DesignCenter (Центр управления) – вызывает палитру, с помощью 
которой можно управлять такими объектами чертежей, как блоки, внешние 
ссылки или образцы штриховки. 

    Подменю Palettes (Палитры) также позволяет вызывать различные 
палитры для работы с освещением, материалами и визуализацией объектов. 
Их применение будет рассмотрено в главах, рассказывающих о работе с 
трехмерными телами. Последняя палитра – dbConnect (Связь с базами 
данных) – предназначена для работы с базами данных. 

    Далее в меню Tools (Сервис) находятся команды: Spelling 
(Правописание), которая позволяет проверить орфографию в выбранном 
пользователем тексте, Quick Select (Быстрый выбор), служащая для быстрого 
создания групп объектов, и Draw Order (Порядок следования), 
предоставляющая возможность переносить объекты на заданный план. 



 

    Подменю New UCS (Новая ПСК) содержит команды для создания 
новых ПСК (пользовательских систем координат) с использованием 
различных методов, а также для редактирования имеющихся систем. 
Команда Named UCS (Именованные ПСК) открывает диалоговое окно, 
отображающее сохраненные пользовательские системы координат. 

    С помощью пункта Drafting Settings (Режимы рисования) можно 
устанавливать необходимые настройки режимов рисования, а пункт Options 
(Параметры) (как говорилось ранее) вызывает одноименное диалоговое окно, 
предназначенное для настройки параметров программы. 

    • Draw (Черчение). Команды этого меню предназначены для 
создания примитивных двух– и трехмерных объектов. 

    · Подменю Modeling (Моделирование) используется для создания 
трехмерных объектов. 

    · Пункт Hatch (Штриховка) позволяет наносить штриховку в 
выбранных областях. 

    · Команда Boundary (Контур) служит для создания области или 
полилинии из замкнутых объектов. 

    · С помощью пункта Wipeout (Маскировка) можно создавать 
различные маскирующие объекты. 

    · Подменю Text (Текст) предназначено для создания одно– или 
многострочного текста. 

    • Dimension (Размер). С помощью команд данного меню можно 
создавать размеры и выноски различных типов, таких как Linear (Линейный), 
Aligned (Параллельный), Ordinate (Ординатный). Здесь же расположены 
команды редактирования размерных надписей. Команда Multileader 
(Мультивыноска) служит для создания мультивыносок (которые заменили 
собой используемые в более ранних версиях программы выноски). Более 
подробно об этом мы поговорим в главе 5, посвященной нанесению 
размеров. 

• Modify (Редактирование). С помощью этого меню можно выполнять 
такие преобразования объектов, как масштабирование, удлинение, поворот и 
др. 
    Кроме того, здесь находятся команды редактирования таких объектов, как 
штриховка, сплайн, текст и др., а также команды различных трехмерных 
операций и редактирования трехмерных тел. 

    Подменю Annotative Object Scale (Масштаб аннотационных 
объектов) позволяет добавлять и удалять значения масштаба аннотационных 
объектов. 



 

    • Parametric (Параметрические). Данное меню содержит команды для 
работы с геометрическими и размерными ограничениями. 

    • Window (Окно). Это меню включает в себя команды, используемые 
при работе с несколькими открытыми чертежами, и служит для поддержки 
многодокументного режима работы. 

    • Help (Справка). В данном меню находятся разделы справки, 
содержащие полную информацию, необходимую для работы в AutoCAD. 
Справочные материалы отображаются в отдельном окне и не мешают работе 
с программой. Более подробно о справочной системе будет рассказано далее. 

    • Express (Дополнительные средства). Это меню содержит 
дополнительные команды различных категорий и обладает собственной 
системой справки (пункт Help (Справка)), а также сборником ответов на 
наиболее часто задаваемые вопросы (пункт Express Tools FAQ (Наиболее 
часто задаваемые вопросы по Express Tools)). 

 
Меню и панели инструментов. 

 
Вверху экрана находится строка заголовка, а сразу под ней строка 

системного меню. Ниже меню располагаются две строки, которые заняты 
панелями инструментов. Кроме того, имеются еще несколько панелей 
инструментов. Эти панели плавающие. 

Их можно переместить в любую удобную зону экрана. Панели 
инструментов позволяют запускать выполнение команд AutoCAD простым 
щелчком мыши на выбранной пиктограмме. В AutoCAD имеются 44 панелей 
инструментов. При стандартной компоновке экрана перед вами только 
четыре панели инструментов – Standard (Стандартная), Object Properties 
(Свойства объектов), Draw (Рисование), Modify (Редактирование). Остальные 
могут быть открыты при необходимости. 
 

Упражнение. Манипулирование панелями инструментов. 
 

Выберите в меню AutoCAD  Tools→Toolbars→AutoCAD  (Сервис → 
Панели инструментов →AutoCAD). В развернутом списке выберите Object 
Snap (Объектная привязка), тем самым вы вызовите на экран панель 
инструментов Object Snap. 
      Установите указатель мыши на четвертой пиктограмме этой панели. 
Появится контекстное окно указателя, в котором будет выведена надпись 
Snap to Midpoint (Середина). Эта пиктограмма вызовет команду, 
обеспечивающую привязку к серединной точке. 



 

Для того чтобы убрать с экрана панель инструментов, которая в на- 
стоящий момент вам уже не нужна, необходимо, “ухватившись” за кромку 
панели, перетащить ее на поле чертежа и отпустить. У панели появится 
строка заголовка и в ней - кнопка Close. Щелчок на этой кнопке убирает 
панель инструментов с экрана. 
       

Командная строка. В нижней части экрана AutoCAD располагается 
отдельное окно, в котором умещается приблизительно три строки текста. 
Обратите внимание на слово Command: (Команда:). Это и есть командная 
строка. Каждая команда, которую вы вводите в AutoCAD тем или иным 
способом (с клавиатуры или нажатием соответствующей пиктограммы), 
обязательно дублируется в командной строке.  
В систему включено множество средств ускоренного вызова таких операций, 
как повторение или отмена команды. Самый простой способ повторить 
только что выполненную команду – нажать Enter в ответ на запрос 
Command: в командной строке. Нажав Esc, можно отказаться от выполне- 
ния текущей команды на любой стадии диалога. После этого в командной 
строке вновь появится приглашение Command:. Большинство приложений 
Windows предлагают пользователю средства отмены и восстановления ре- 
зультатов выполнения последней команды. Эти операции выполняются 

при помощи специальных пиктограмм  Undo (Отменить) и Redo 
(Повторить) на стандартной панели инструментов. 
 

Строка состояния. В самом низу экрана находится строка состояния. 
Слева в строке состояния выведены текущие координаты X, Y перекрестия. 
Они изменяются по мере перемещения перекрестия с помощью мыши в 
пределах графической зоны экрана. Правее расположено несколько 
кнопок, о назначении которых будет рассказано позже. 

 
Создание файла рисунка. 

 
    Из меню File (Файл) выберите New (Новый). 
В раскрывающемся списке Select template (Выберите шаблон). 
Выберите файл Acadiso.dwt. 

 
Установка среды рисования. 

 



 

Из меню Format (Формат) выберите Units (Единицы). 
В диалоговом окне Drawing Units выберите Precision (Точность) 0.0, 

затем OК. 
Из меню Format выберите Drawing limits (Лимиты чертежа). 
В командной строке появится запрос: Specify lower left corner or [On 

|Off] <0.0,0.0>: (Нижний левый угол<0.0,0.0>:). - Нажмите Enter, чтобы 
принять значение по умолчанию. 

Запрос: Specify upper right corner <420.0,297.0>: (Правый верхний 
угол<420.0,297.0>:). - Наберите 210,297 и Enter. 

Из меню Tools (Сервис) выберите Drаfting Settings (Режимы рисования) 
(рис.2) и активизируйте вкладку Snap and Grid (Шаг и сетка). Поставьте 
флажок Grid On(F7) в рамке Grid (Сетка) для установки на экране 
вспомогательной сетки. Установите Grid X Spacing (Интервал по X) в рамке 
Grid равным 5 и нажмите OК. На экране появится сетка. 
 
 

 
Рис.2  

 
Вычерчивание окружностей 

Вы можете нарисовать окружность, используя кнопку команды Circle 
(Круг) на панели инструментов Draw, набирая команду Circle в командной 
строке или используя меню Draw. 

Щелкните на пиктограмме Circle панели инструментов Draw. 
Запрос: Specify center point for circle or [3Р/2Р/TTR (tan tan radius)]: 

(Центральная точка или [3T/2T/KKP]:). – Наберите в командной строке 
координаты центральной точки: 100,180 Enter. 



 

Запрос: Specify radius of circle or [Diametеr]: (Радиус или [Диаметр]:). - 
Введите 40, Enter. 

Получили окружность с радиусом 40 и центром в точке с координата- 
ми 100,180. 

С помощью полос прокрутки (стрелки снизу и справа экрана) 
переместите изображение в центр графической зоны. 

Самостоятельно нарисуйте окружности с центрами в точках (35,180) и 
(165,180) и с радиусами равными 10. 
 
Изображение на дисплее должно соответствовать рис. 3. 

 
 

Рис. 3 
 

Удаление объектов. 
 

Без удаления объектов не обходится ни один процесс построения 
чертежа. Если вы ошиблись и вам необходимо удалить какой-либо объект, 
примените команду Erase (Стереть). Нужно выбрать объект (щелчком мы- 
ши) и щелкнуть на пиктограмме Erase панели инструментов Modify . 
 

Создание подобных объектов. 
 

        Щелкните на пиктограмме команды Offset (Подобие) панели 
инструментов Modify. Команда Offset конструирует объект, подобный 
данному, на установленном расстоянии. 
Запрос: Specify offset distance or [Through/Erase/Layer] <Through>: (Укажите 
расстояние смещения или [Через/Удалить/Слой] <Через>:) 
- Наберите 10 и Enter. 



 

Запрос: Select object to offset or [Exit/Undo]<Exit>: (Выберите объект 
для смещения или [Выход/Отменить] <Выход>:) 
Установите курсор на линию левой окружности, щелкните один раз мышью. 

Запрос: Specify point on side to offset or [Exit/Multiple/Undo] <Exit>: 
(Укажите точку, определяющую сторону смещения, или 
[Выход/Несколько/Отменить] <Выход>:).  -Выберите любую точку вне левой 
окружности. 

 
Запрос: Select object to offset or [Exit/Undo]<Exit>: (Выберите объект 

для смещения или [Выход/Отменить] <Выход>:) 
Установите курсор на линию правой окружности, щелкните один раз 
мышью. 

Запрос: Specify point on side to offset or [Exit/Multiple/Undo] <Exit>: 
(Укажите точку, определяющую сторону смещения, или 
[Выход/Несколько/Отменить]  
<Выход>:). -Выберите любую точку вне правой окружности. 

Запрос: Select object to offset or [Exit/Undo]<Exit>: (Выберите объект 
для смещения или [Выход/Отменить] <Выход>:) 
 - Установите курсор на линию средней окружности, щелкните один раз 
мышью. 

Запрос: Specify point on side to offset or [Exit/Multiple/Undo] <Exit>: 
(Укажите точку, определяющую сторону смещения, или 
[Выход/Несколько/Отменить]  
<Выход:) -Выберите любую точку внутри окружности. 

Запрос: Select object to offset or [Exit/Undo]<Exit>: (Выберите объект 
для смещения или [Выход/Отменить] <Выход>:) 
- Установите курсор на линию только что полученной окружности, щелкните 
один раз мышью. 

Запрос: Specify point on side to offset or [Exit/Multiple/Undo] <Exit>: 
(Укажите точку, определяющую сторону смещения, или 
[Выход/Несколько/Отменить] <Выход:)  ;- Выберите любую точку внутри 
окружности. 

Запрос: Select object to offset or [Exit/Undo]<Exit>: (Выберите объект 
для смещения или [Выход/Отменить] <Выход>:)- Нажмите Enter, чтобы 
закончить команду. 

     Изображение на дисплее должно соответствовать рис.4 
 

 
 



 

 
 
 

 
 

Рис. 4 
 

Рисование линий, соединяющих окружности. 
 

Из панели инструментов Draw выберите Line (Отрезок). AutoCAD 
запрашивает начальную точку линии, которую вы хотите нарисовать. 

Запрос: Specify first point: (Первая точка:). - На панели инструментов 
Object Snap (Объектная привязка) нажмите кнопку Snap to tangent 
(Касательная) или в командной строке наберите команду Tan to. 

Запрос: Line Specify first point tan to: (Первая точка по касательной:).- 
Выберите нижнюю точку левой внешней окружности (должен появиться 
кружок с касательной) и щелкните мышью. 

Запрос: Specify next point or[Undo]: (Следующая точка или [Отмена]:). 
- С помощью команды Snap to tangent выберите нижнюю точку средней 
внешней окружности и нажмите Enter, чтобы закончить команду Line. 
Повторите команду Line (Для этого необходимо щелкнуть правой 
кнопкой мыши или нажать Enter). 

Запрос: Line Specify first point: (Первая точка:). - На панели инстру- 
ментов Object Snap (Объектная привязка) нажмите кнопку Snap to tangent 
(Касательная) или в командной строке наберите команду Tan to. 

Запрос: Line Specify first point:tan to: (Первая точка по касательной:).- 
Выберите нижнюю точку правой внешней окружности (должен появиться 
кружок с касательной) и щелкните мышью. 

Запрос: Specify next point or[Undo]: (Следующая точка или [Отмена]:). 
С помощью команды Snap to tangent выберите нижнюю точку средней 
внешней окружности и нажмите Enter, чтобы закончить команду Line. 



 

Изображение на дисплее должно соответствовать рис. 5. 

 
 

Рис. 5 
 

Использование команды Mirror (Зеркало). 
 

Чтобы не повторять команду Line для построения верхних линий, мы 
можем использовать команду Mirror. Она создает копию существующего 
объекта способом отражения на другую сторону оси, определенной двумя 
точками. 

Из панели инструментов Modify выберите Mirror. AutoCAD запраши- 
вает объекты для отражения. Существуют много путей выбора объектов. 

Например, можно выбрать объекты, щелкнув на них мышью или 
обводя их в рамку. 

Запрос: Select Objects: (Выберите объекты:). – Щелкните поочередно 
на двух линиях мышью. 

Запрос: Select Objects: (Выберите объекты:). - Нажмите Enter, чтобы 
закончить выбор объектов. 

Запрос: Specify first point of mirror line: (Первая точка оси 
отражения:).- Из панели Object Snap выберите Snap to Center (Центр-
Привязка к центру).  

Запрос: Specify first point of mirror line cen of. - Выберите внешний  
левый круг (должен появиться маркер в форме круга). 

Запрос: Specify second point of mirror line: (Вторая точка:).- Из панели 
Object Snap выберите Snap to Center (Привязка к центру). 

Запрос: Specify second point of mirror line cen of. - Выберите внешний 
правый круг. 

Запрос: Erase source object? [Yes/No] <N>: (Удалить исходный объ- 
ект? [Да/Нет] <Н>). - В данном случае мы хотим его оставить. Наберите N 
(No) или нажмите Enter, чтобы принять значение по умолчанию. 



 

Изображение на дисплее должно соответствовать рис. 6. 
 
 

 
Рис.6 

 
Обрезка линий. 

 
Чтобы закончить упражнение, примените команду Trim (Обрезать). 
Прежде чем удалить (подрезать) часть объекта, необходимо 

определить границы обрезки. Можно выбирать несколько границ и подрезать 
несколько объектов одновременно. В данном упражнении границами обрезки 
будут линии, соединяющие окружности. 

Из панели инструментов Modify выберите Trim. 
Запрос: Select cutting edge. Select objects: (Выберите режущие кромки:) 

Выберите четыре линии, соединяющие окружности. 
Запрос: Select objects: (Выберите объекты:). - Нажмите Enter, чтобы 

закончить выбор объектов. 
Запрос: Select objects to trim or shift – select to extend 

or…[Fence/Crossing/Project/Edge/Erase/Undo]: (Выберите подрезаемые 
объекты … [Линия/Секрамка/Проекция/Кромка/Удалить/Отменить]:) 
- Выберите части окружностей, отмеченные на рис. 6 стрелками. Нажми- 
те Enter, чтобы закончить выбор объектов.  
Изображение на дисплее должно соответствовать рис. 7. 
 

Завершение сеанса работы с AutoCAD. 
 

Как и любая другая программа Windows, AutoCAD позволяет завер- 
шить работу с системой разными способами. 
 Самое простое – использовать кнопку Close (Закрыть) в правом верхнем 
углу экрана.  



 

Второй способ – выбрать в меню File → Exit (Файл → Выход). Если в 
ходе сеанса работы вы не сохраняли рисунок, то AutoCAD предложит 
сохранить его. В зависимости от ситуации вы можете либо принять 
предложение (щелчок на Yes), либо отвергнуть (щелкнуть на No). 
 
 

 
Рис.7 

 
 

 

 Вопросы для самоконтроля 
 

 
1. Как осуществляется запуск AutoCAD в операционной среде Windows? 
2. Какие опции (режимы) установки параметров чертежа вы знаете? 
3. Что представляет собой рабочий экран AutoCAD? 
4. Как установить на рабочий экран нужную панель инструментов? 
5. Что необходимо сделать на этапе подготовительных действий? 
6. В каком меню находятся команды рисования? 
7. Какой примитив рисует команда Circle? 
8. Как создать подобные объекты? 
9. С помощью какой команды можно удалить объект? 
10. Как построить симметричное изображение? 
11. Как осуществить отсечение объектов по границе? 
12. Как завершить сеанс работы с AutoCAD? 

 
 
 



 

 

Практическое задание 
 

Повторите нижеследующие рисунки. 

 

              Вариант 1.                                        Вариант 2. 

                              

         Вариант 3.                                                    Вариант 4. 

                                

        Вариант 5.                                                  Вариант 6. 



 

                                
             Вариант 7.                                                            Вариант 8. 
 
 

             
 
                     Вариант 9.                                          Вариант 10. 
 
 
 
 
 
 
 
 
 
 



 

 

Практическая работа № 2 

 
РАБОТА СО СЛОЯМИ, ТИПАМИ ЛИНИЙ, ЦВЕТОМ 

 

Цель занятия 

 

Приобретение практических навыков работы со слоями чертежа, в 
использовании цвета и различных типов линий. Выполнение упражнений 
по применению команд Mline, Mledit, Arc, Zoom и использованию объект- 
ных привязок к конечной точке, пересечению, ближайшей точке. 

 
Порядок выполнения 

Практическая работа заключается в последовательной реализации 
нижеследующего интерактивного диалога с системой автоматизированно- 
го проектирования AutoCAD 2010 и выполнении индивидуального задания. 
 

Создание файла рисунка 
 
Запустите AutoCAD. Создайте новый файл. Выберите метрические единицы. 
 

Создание нового слоя 
 
Создание слоев – один из важных этапов настройки чертежа. Слои можно 
сравнить с листами прозрачной бумаги, которые наложены друг на друга. 
Чертеж может иметь неограниченное число слоев. Каждый слой должен 
иметь имя, цвет, тип линии и толщину линии. Имя может иметь длину до 256 
символов и не должно содержать пробелов. По умолчанию при создании 
любого чертежа в него обязательно включается слой 0. Слои имеют три 
параметра состояния: On / Off (Включен/Отключен) – если для слоя 
установлено состояние On (значок светящейся лампочки), слой отображается 
на экране; Thaw / Freeze (Размороженный / Замороженный) - имеют более 
высокий приоритет, чем свойства On и Off, замороженные слои невидимы 
даже в состоянии On; Unlock / Lock (Разблокированный / 



 

Заблокированный) – слои со свойством Lock (значок закрытого замка) 
защищены от редактирования, но они видимы и могут быть распечатаны.



 

Чтобы создать новый слой, щелкните на пиктограмме Layers 
(Слои) или из меню Format (формат) выберите Layer. AutoCAD откроет 
диалоговое окно Layers Properties Manager (Менеджер свойств слоя) (рис 1). 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Рис. 1. 

Щелкните на кнопке New . Появится новый слой, который AutoCAD по 
умолчанию предложит назвать Layer1 (Слой 1).  
     Имя будет выделено, при желании можно впечатать другое имя для 
вновь созданного слоя. 

 
 

Рис.2 



 

 
 В данном упражнении назовем слой Walls, так как мы будем рисовать 
план комнаты. Чтобы изменить цвет, установленный по умолчанию, под- 
ведите курсор к квадратику в строке, соответствующей новому слою. Поя- 
вится диалоговое окно Select Color (Выбор цвета) (рис. 2). 
Щелкните мышью на желаемом цвете (например синем). 
Чтобы изменить тип линии, установленный по умолчанию, передвиньте 
курсор на тип линии Continuous (Сплошной) 
и щелкните мышью. 
     При этом откроется окно Select linetype (Выбор типа линии) (рис. 3). 
Если в списке отсутствует нужный тип линии, нажмите Load (Загрузить). 
    Выберите нужный тип линии. 
Возвратитесь к окну Select linetype. В списке появится загруженный 
тип линии, выберите его. 

 
Рис. 3 

 
Перейдите к вкладке Layers. В строке, соответствующей новому слою, 
показаны цвет и тип линии, которые ему назначили. Чтобы сделать слой 

текущим, нажмите кнопку Current (Текущий).  
Нажмите ОК, принимая вышеописанные изменения. 
Теперь слой Walls – текущий, и цвет его линий – синий. 
 

Вычерчивание стен комнаты. 
О задании координат в AutoCAD. 

 
Ввод координат в AutoCAD может быть осуществлен двумя способами: 

- непосредственно с клавиатуры путем задания численного значения; 
- с использованием мыши. 



 

Ввод с клавиатуры возможен в виде чисел, соответствующих 
абсолютным (см. практ. работу № 1) и относительным координатам точки; 
относительные координаты задают смещение от последней введенной точки. 
Формат относительных координат @dx,dy. 
Пример. Дана начальная точка, и необходимо построить горизонталь- 
ный отрезок длиной 200 единиц. 

Об объектной привязке. 
 

 Иногда новые объекты на чертеже должны 
быть привязаны к ранее вычерченным. Например, новый отрезок должен 
начинаться в одной из точек отрезка, вычерченного ранее. В AutoCAD 
имеются функции объектной привязки Osnap (Object Snap), которые по- 
зволяют задавать новые точки относительно характерных точек уже суще- 
ствующих объектов (рис. 4). 

 
Рис. 4 

Запуск объектной привязки можно выполнить одним из следующих 
способов: 
- с помощью панели Object Snap; 
- установкой текущего режима объектной привязки. 

В меню AutoCAD выберите Tools → Drafting Settings (Сервис →Режим 
рисования). Откроется диалоговое окно Drafting Settings (рис. 5), в 
котором нужно выбрать вкладку Object snap (Объектная привязка). 
Установите в ней флажки нужных вам опций и щелкните ОК. 
 
 
 



 

 
Рис. 5 

Если необходимо временно выключить текущую привязку, можно 
просто сделать щелчок на Osnap в строке состояния. 
 

Для выполнения данного упражнения включить режимы Endpoint 
 Важное замечание. 

(Конточка), Nearest (Ближайшая), Intersection (Пересечение). 
 

О команде Multiline. 
 

 Мультилинией называют набор 
параллельных линий, которые создаются одновременно с 
помощью одной команды. Для каждой из этих линий можно задать свой 
цвет и тип, а также расстояние между ними. Отдельная команда 
предусмотрена для изменений мультилиний. 

Из панели инструментов Draw (Рисование) выберите Multiline или 
наберите в командной строке команду Mline. 
Запрос: Specify start point or [Justification / Scale / Style /]: (Начальная 
точка или [Расположение / Масштаб / Стиль /]:). - Наберите S (масштаб), 
Enter, чтобы установить расстояние между линиями. 



 

Запрос: Enter Mline Scale <20.00>: (Масштаб мультилинии :). - 
Наберите 6 и нажмите Enter. 

Запрос: Specify start point or [Justification / Scale / Style /]: (Начальная 
точка или [Расположение/ Масштаб / Стиль /]:). - Задайте координаты 
начальной точки, а затем относительные координаты следующих точек: 36, 
12; Enter. 

Запрос: Specify next point or [Undo]: (Следующая точка :) 
- @ 96, 0; Enter. 

Запрос: Specify next point or [Close/Undo]: (Следующая точка или 
отменить:). - @ 0,132; Enter. 

Запрос: Specify next point or [Close/Undo]:. - @ -120, 0; Enter. 
Запрос: Specify next point or [Close/Undo]:. - @ 0, -96; Enter. 
Запрос: Specify next point or [Close/Undo]:. - Наберите С (Сlose), чтобы 

замкнуть контур, и Enter. 
Расположите рисунок в центре графической зоны с помощью полос 

прокрутки (стрелки снизу и справа экрана) и увеличьте его с помощью 
команды Zoom (зумирование). 
 

О команде Zoom. 
 

Эта команда позволяет управлять масштабом чертежа на экране. 
Опции команды Zoom: 
- Window (Рамка) – позволяет определить прямоугольную рамку, 

которая рассматривается как новые границы видимой на экране части черте- 
жа; 

- Dynamic (Динамика) – позволяет одновременно выполнять 
масштабирование и панорамирование; 

- Scalе (Масштаб) – позволяет при помощи ввода численных значений 
управлять масштабом чертежа; 

- Center ( По центру) – позволяет задать новое положение центра 
выводимого на экран участка чертежа и его масштабный коэффициент; 

- In (Увеличение) – дублирует опцию Scalе с удвоением 
коэффициента; 

- Out (Уменьшение) – дублирует опцию Scalе с уменьшением 
коэффициента вдвое; 

- All (Все) – масштабирует изображение таким образом, чтобы лимиты 
чертежа совпали с графической зоной экрана; 



 

- Extents (Границы) - масштабирует изображение таким образом, 
чтобы в графическую зону экрана попали все имеющиеся на чертеже 
графические элементы; 

- Previous (Предыдущий) – восстанавливает предыдущие параметры 
масштабирования. 

 

Рисование двери. 
 

Следующим этапом будет рисование двери и обозначение ее размаха. 
Для того, чтобы задать начальную точку линии на 

определенном расстоянии от стены, будем использовать привязку 
объектов From (От). 

 
Рис.6 

 
 
Из панели инструментов Draw (Рисование) выберите Line. 
   Запрос: Specify first point: (Первая точка:). –Наберите в командной строке 
From(от) и нажмите Enter. 
   Запрос: Base point: (Базовая точка). – С помощью привязки к конечной 
точке 
(квадрат) установите точку1 (рис. 6). 
Запрос: Offset>:(<Смещение>:). – Задайте@-8, 0; Enter. 
Запрос: Specify next poin or [Undo] (Следующая точка или [Отмена]). - 
Наберите @ 0, 40; Enter. 



 

 
 

 
 
 
 
 
 
 
 
 
 
                Рис.7 

 
Запрос: Specify next poin or [Undo]: (Следующая точка или [Отмена]:) - 
Нажмите Enter, чтобы закончить команду Line. На экране должно получиться 
изображение чертежа, соответствующее рис. 7. 
      Нарисуем дугу, чтобы обозначить размах двери. 
Схема на рис. 8 объясняет геометрический смысл параметров, используемых 
при построении дуги. 

 
 
 
 
 
 
 
 
 
 
 
 

 
Рис.8 

В данном упражнении мы будем использовать опцию Center (Центр). 
Из панели инструментов Draw выберите команду Arc (Дуга). 
Запрос: Specify start point of arc or [Center]:(Начальная точка дуги или 

[Центр]:). - Наберите С и Enter. 



 

 
Рис.9 

Запрос: Specify center point of arc:. - С помощью привязки к конечной 
точке выберите точку, соответствующую 1 на рис. 9. 
Запрос: Specify start point of arc: (Начальная точка дуги:). - С помощью той 
же привязки установите точку 2. 
Запрос: Specify end point of arc or [Angle / 
chord Length]:(Конечная точка дуги или [Угол /Длина хорды]:). С помощью 
привязки к ближайшей точке выберите точку 3. 
Следующий этап - создание дверного проема. 
     Для этих целей используем команду Multiline панели инструментов Modify  
(Редактировать)  
Из панели инструментов Modify  на вкладке Objects выберите вкладку 
Multiline На экране появится диалоговое окно Multilines Edit Tools  
(Инструменты редактирования мультилиний) (рис. 11). В данном диалоговом 
окне выберите в крайнем правом столбце средний рисунок Cut                     
all (Обрезать все) и нажмите ОК. 
 

 
 

Рис.10. 
 



 

 
Запрос: Select Мline: (Выберите мультилинию:). - Для выбора исполь- 

зуйте привязку к пересечению  . Выберите точку 3 (см. рис. 9.)  
Запрос: Select second point: (Выберите вторую точку:). – Выберите 
точку 1 (см. рис. 9). 
Запрос: Select Mline (or Undo): (Выберите мультилинию (или Отме- 
на):). - Нажмите Enter. 
Из панели инструментов выберите Line. 
Запрос: Specify first point (Первая точка). - С помощью привязки к ко- 
нечной точке установите точку, соответствующую 1 на рис. 11. 
Запрос: Specify next poin or [Undo:] (Следующая точка или [Отмена:]). 
- Установите точку 2. Нажмите Enter. 
Аналогично постройте линию между точками 3 и 4. 
Окончательное  изображение, сформированное на экране дисплея, 
должно соответствовать рис. 12. 
 
 
 
 
 
 
 
 
 
 
 
 
 
                  Рис. 11                                                              Рис. 12 
 
 

Вопросы для самоконтроля. 
 

1. Как создать новый слой чертежа? 
2. Как выбрать нужный тип линии для данного слоя? 
3. Как изменить цвет, установленный по умолчанию? 
4. Какими способами осуществляется ввод координат? 



 

5. Что задают относительные координаты и каков их формат? 
6. Как произвести запуск объектной привязки? 
7. Где находится индикатор OSNAP и что он устанавливает? 
8. Какое действие на изображение оказывает команда Zoom? 
9. В каком меню находится команда Mline? 
10. Что такое мультилиния? 
11. Какой примитив рисует команда Arc? 
 

Практическое задание 
 
Используя графические примитивы панели инструментов Draw, нари- 
суйте план вашей комнаты. 
 



 

Практическая работа № 3 
РАЗРЕЗ ДЕТАЛИ. 

 
Цель занятия 

 
Приобретение практических навыков в использовании основных 

команд AutoCAD 2010: Offset, Extend, Erase, Fillet, Hatch. Выполнение 
упражнений по использованию объектной привязки (к конечной точке, к 
середине, перпендикуляр), созданию слоев, изменению типа линий, 
использованию режима ORTHO. 

 
Порядок выполнения. 

 
Практическая работа состоит в последовательном интерактивном 

диалоге с системой для выполнения следующих действий: 
- создание файла рисунка; 
- создание слоев, установка режимов объектной привязки и режима ORTHO; 
- вычерчивание половины детали; 
- формирование всей детали; 
- скругление углов; 
- штриховка. 

Создание файла рисунка. 
 
Из меню File (Файл) выберите New (Новый). В открывшемся окне Select 
template (Выбор шаблона) выберите файл Acadiso.dwt. AutoCAD откроет 
новый файл рисунка (Рис. 1.). 
 

Создание слоев, установка режимов объектной привязки 
и режима ORTHO. 

 
Создаем три слоя (см. практ. работу № 2). 
Первый слой (за нулевым) имеет имя OSI. Он предназначен для нане- 

сения на рисунок осевых линий отверстий. Этот слой имеет свой цвет (на- 
пример синий); тип линии Center2, ширина линии 0.3. 

Второй слой – OTV, предназначен для нанесения на рисунок границ 
отверстий. Имеет тип линии Continuos (Сплошная), красный цвет, ширину 
линии 0.8. 

 



 

Третий слой – SHTR (Штриховка), тип линии Continuos, ширина ли- 
нии 0.4. 

 
 

Рис. 1. 
 

Устанавливаем привязку объектов (см. практ. работу № 2) к середи- 
не (Midpoint), перпендикуляр (Perpendicular), привязку к конечной точке 
(Endpoint). 

Включаем режим ORTHO. Для этого сделайте щелчок мышью на 
одноименном индикаторе в строке состояния (рис. 2). 
 

 
 

Рис. 2 
 

В этом режиме система принудительно проводит только ортогональ- 
ные линии (под углом 0°, 90°, 180°, 270°). Ортогональный режим действу- 
ет только по отношению к точкам, которые вы указываете мышью на экра- 
не. Если же точка задается вводом значений координат с клавиатуры, то 
введенные значения имеют более высокий приоритет – они воспринима- 
ются системой AutoCAD независимо от установки режима. 



 

 
Вычерчивание половины детали. 

 
Вычерчиваем контур детали. 

 
Из панели инструментов Draw выберите Polyline. 

Запрос: Specify start point: (начальная точка:). - 
Набираем 270, 120; Enter. 

Запрос: Specify next point or [Arc/Halfwidth/Undo/Width]: (Следующая 
точка или [Дуга/Полуширина/длИна/Отменить/Ширина]:). - @ -160, 0 Enter. 

Запрос: Specify next point or [Arc/Halfwidth/Undo/Width]: (Следующая 
точка или [Дуга/Полуширина/длИна/Отменить/Ширина]:). - @ 0, 40 Enter. 

Запрос: Specify next point or [Arc/Halfwidth/Undo/Width]: (Следующая 
точка или [Дуга/Полуширина/длИна/Отменить/Ширина]:). - @ 40, 0 Enter. 

Запрос: Specify next point or [Arc/Halfwidth/Undo/Width]: (Следующая 
точка или [Дуга/Полуширина/длИна/Отменить/Ширина]:). - @ 0, 40 Enter. 

Запрос: Specify next point or [Arc/Halfwidth/Undo/Width]: (Следующая 
точка или [Дуга/Полуширина/длИна/Отменить/Ширина]:).- @ 20, 0 Enter. 

Запрос: Specify next point or [Arc/Halfwidth/Undo/Width]: (Следующая 
точка или [Дуга/Полуширина/длИна/Отменить/Ширина]:).- @ 0, -10 Enter. 

Запрос: Specify next point or [Arc/Halfwidth/Undo/Width]: (Следующая 
точка или [Дуга/Полуширина/длИна/Отменить/Ширина]:).- @ 40, 0 Enter. 

Запрос: Specify next point or [Arc/Halfwidth/Undo/Width]: (Следующая 
точка или [Дуга/Полуширина/длИна/Отменить/Ширина]:).- Нажмите Enter, 
чтобы закончить команду. 

Если ваша деталь находится не в центре экрана, перенесите ее с по- 
мощью полос прокрутки (стрелочки в нижней и правой части экрана). 

Изображение на дисплее должно соответствовать рис. 3. 

 
Рис.3 



 

 
 

Создание слоев, установка режимов объектной привязки 
и режима ORTHO. 

 
Создаем три слоя (см. практ. работу № 2). 
Первый слой (за нулевым) имеет имя OSI. Он предназначен для нане- 

сения на рисунок осевых линий отверстий. Этот слой имеет свой цвет (на- 
пример синий); тип линии Center2, ширина линии 0.3. 

Второй слой – OTV, предназначен для нанесения на рисунок границ 
отверстий. Имеет тип линии Continuos (Сплошная), красный цвет, ширину 
линии 0.8. 

Третий слой – SHTR (Штриховка), тип линии Continuos, ширина ли- 
нии 0.4. 

 
Вычерчиваем осевые линии. 

 
На панели инструментов Draw щелкните Polyline. 
Запрос: Specify start point: (Начальная точка:). - Используя привязку к 

середине, выбираем линию 1 (см. рис. 3) и строим перпендикуляр к линии 
2 (осевая линия малого отверстия). 

Аналогично начертим осевую линию центрального (большого) отвер- 
стия (см. рис. 3, линии 2, 3). 

 
Обозначаем диаметры отверстий. 

 
Малое отверстие. В панели инструментов Modify щелкните Offset 

(Подобие). 
Запрос: Specify offset distance or [Through/Erase/Layer] <Through>: 

(Укажите расстояние смещения или [Через/Удалить/Слой] <Через>:) 
Наберите 10; Enter. 

Запрос: Select object to offset or [Exit/Undo] <Exit>: (Выберите объект 
для смещения или [Выход/Отменить] <Выход>:). - Выберите осевую линию 
малого отверстия. 

Запрос: Specify point on side to offset or [Exit/Multiple/Undo] <Exit>: 
(Укажите точку, определяющую сторону смещения, или 
[Выход/Несколько/Отменить]  
<Выход>:). - Выберите любую точку справа от линии. 



 

Запрос: Select object to offset or [Exit/Undo] <Exit>:– Выберите осевую 
линию. 

Запрос: Specify point on side to offset or [Exit/Multiple/Undo] <Exit>: – 
Выберите любую точку слева от линии. 

Запрос: Specify point on side to offset or [Exit/Multiple/Undo] <Exit>: – 
Нажмите Enter. 

Центральное отверстие получаем аналогично, но вычерчиваем только 
линию слева, так как будем зеркально отражать половину детали 
относительно осевой линии. Дистанцию установим равной 30.  

Изображение на дисплее должно соответствовать рис. 4. 
 

 
Рис. 4. 

Отверстия обозначены в слое OSI, хотя для этих целей был создан 
слой Edge. Чтобы изменить слой, применим команду Change properties 
(Изменение свойств). Наберите Chprop в командной строке и нажмите 
Enter. 

Запрос: Select Objects:. - Выберите только что полученные линии 2, 3, 
4 (см. рис. 4). Нажмите Enter, чтобы закончить выбор объектов. 

Запрос Enter property to change  (Color/…)? (Какие свойства вы хотите 
изменить (Цвет/…)?). - Мы хотим изменить слой, поэтому набираем Layer 
и Enter. 

Запрос: Change what… - Нажмите Enter, чтобы закончить команду. 
   
  Удлиним линии с помощью команд Offset и Extend (Удлинить). 
Щелкните на пиктограмме Extend панели инструментов Modify. 

Запрос: Select boundary edges (…) Select objects: (Выбрать граничные 
кромки: (…). Выбрать объекты:). - Выберем линию 1 (см.рис. 4). Для 
завершения выбора нажмите Enter. 

Запрос: Select objects to extend …: (Выбрать объекты для удлинения 

1 

2 
 



 

…:). - Выберем точку на конце линии 2 (см. рис. 4). Нажмите Enter. 
Построим вспомогательные линии. В меню Modify выберите Offset. 
Запрос: Specify offset distance or [Through/Erase/Layer] <30.0000>: 

(Укажите расстояние смещения или [Через/Удалить/Слой] <30.0000>:). - 
Наберите 5 Enter. 

Запрос: Select object to offset or [Exit/Undo] <Exit>: (Выберите объект 
для смещения или [Выход/Отменить] <Выход>:). - Выберите линию 1 ( рис. 
4). 

Запрос: Specify point on side to offset or [Exit/Multiple/Undo] <Exit>: 
(Укажите точку, определяющую сторону смещения, или 
[Выход/Несколько/Отменить]  <Выход>:). - Выберите любую точку сверху от 
линии 1. 
 

Для команды Extend (Удлинить) используются те же приглашения, что 
и для команды Trim (Обрезать). При выборе объектов для удлинения 
необходимо указывать линию с той стороны объекта, которую необходимо 
удлинить. Щелкните на пиктограмме Extend панели инструментов Modify. 
 

Запрос: Select boundary edges (…)Select objects or <select all>: (Выбрать 
граничные кромки: (…) Выбрать объекты или <выбрать все>:). - Выберем 
полученные вспомогательные линии.  
Для завершения выбора нажмите Enter. 
 

Запрос: Select object to extend or shift-select to trim or 
[Fence/Crossing/Project/Edge/Undo]: (Выбрать объекты для удлинения) берем 
точки на концах всех осевых линий. Нажмите Enter. 
Изображение на дисплее должно соответствовать рис. 5. 

 

 
Рис. 5. 

 



 

 
Щелкните на пиктограмме Erase (Стереть). 
 

Запрос: Select object:. - Выберите вспомогательные линии и нажмите 
Enter. Линии удалены. 
 

Формирование всей детали. 
 
   В панели инструментов Modify выберите команду Mirror (Зеркало). 

Запрос: Select object:. - Щелкните мышью в левом верхнем углу и 
растяните окно выбора, охватив левую часть детали. 
Нажмите Enter, чтобы закончить выбор объектов. 
Чтобы обозначить ось отражения, используйте привязку к конечной 
точке. 

Запрос: Specify first point of mirror line: (Точно определите первую 
Точку оси отражения:). - Выберите верхнюю конечную точку осевой линии 
центрального отверстия. 

: Specify second point: (Точно определите вторую точку:). - Выберите 
любую точку по направлению к другому концу осевой линии. 

Запрос: Delete source object? [Yes/No] <N>: (Удалить исходный объект? 
[Да/Нет] <Нет>:). - Нажмите Enter, чтобы принять значение по умолчанию. 
 
Изображение на дисплее должно соответствовать рис. 6. 
 

 
Рис. 6. 
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Скругление углов. 

 
     Команда Fillet (Сопряжение). Процесс сопряжения двухшаговый. 

Сначала определяется радиус сопрягающей дуги, затем выбираются два 
сопрягаемых отрезка. 

Щелкните на пиктограмме Fillet  панели Modify. 
Запрос: Select first object or [Undo/Polyline / Radius / Trim/Multiple]: 

(Выберите первый объект или 
[оТменить/полИлиния/раДиус/оБрезка/Несколько]- Введите R. Нажмите 
Enter. 

Запрос: Specify fillet radius <0.0000>: (Точно определите радиус 
сопряжения:). - Введите 5 Enter. 

Запрос: Select first object or [Undo /Polyline / Radius / Trim/ Multiple]: 
(Выберите первый объект или 
[оТменить/полИлиния/раДиус/оБрезка/Несколько]:). - Выберите линию а. 

Запрос: Select second objec or shift-select to apply corner: (Выберите 
второй объект: Выберите второй объект или нажмите клавишу Shift при 
выборе, чтобы создать угол:). – Выберите линию b. 
 
Повторите команду Fillet для другой пары линий a и b. 
 

Штриховка. 
 

   Для создания штриховки смените текущий слой на SHTR. 
Щелкните на пиктограмме Hatch (Штриховка) панели Draw. 
При этом будет открыто диалоговое окно  Hatch and Gradient 
(Штриховка и градиент) (Рис. 7.) 



 

 
Рис. 7. 

 
 Изображение на дисплее должно соответствовать рис. 8.                   
Сохраните полученный рисунок.  
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис.8 
 
 
 
 



 

Вопросы для самоконтроля 

  
1. В каком меню находятся команды редактирования? 
2. Как построить симметричное изображение? 
3. Какая команда изменяет свойства объекта? 
4. Как создать подобные объекты? 
5. Как можно «вытянуть» объект до границы? 
6. Какова последовательность действий при выполнении команды Extend? 
7. Какая команда осуществляет сопряжение ? 
8. Какова последовательность действий при выполнении команды 
Fillet? 
9. Какая команда позволяет штриховать область? 
10. Как выбрать шаблон штриховки? 
11. Как выбрать область штриховки? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

Практическое задание 
 
Начертить две проекции прототипов деталей, сделать разрез 

 
 
             Вариант 1.                                          Вариант 2. 
 

   
 
                   Вариант 3.                                            Вариант 4. 



 

   
                    Вариант 5.                                          Вариант 6. 

   
                Вариант 7.                                     Вариант 8. 
 
 



 

   
                 Вариант 9.                                               Вариант 10. 
 
 
   
 
               
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

Практическая работа № 4 
 

НАНЕСЕНИЕ РАЗМЕРОВ 

 
 

 Цель занятия. 
 

Приобретение практических навыков в работе с размерами в 
AutoCAD 2010. Создание размерного стиля, нанесение размерных цепей и 
размеров от общей базы. Выполнение упражнений по нанесению и редак- 
тированию линейных, радиальных и угловых размеров. 
 

Порядок выполнения. 
 

Практическая работа заключается в последовательной реализации 
нижеследующего интерактивного диалога с системой автоматизированного 
проектирования AutoCAD 2010 и выполнении индивидуального задания. 
 

Подготовка к нанесению размеров. 
 
Откройте файл чертежа «Разрез детали» (см. практ. работу № 3). 
Создайте отдельный слой для размеров. Очень важно, чтобы 

размерные надписи и линии можно было легко отличить от основных линий. 
Цвет размеров обычно выбирается контрастным цвету модели. О создании 
нового слоя - в практической работе № 2. 

Воспользуйтесь командой меню Tools → Drafting Settings (Сервис→ 
Режимы рисования), выберите вкладку Object snap (объектная привязка) и 
установите нужные опции объектной привязки. 
Необходимы привязки к конечной точке (Endpoint) и к точке пересечения 
(Intersection). Если потребуется проставлять размеры дуг и окружностей, 
добавьте привязки к центру. 
AutoCAD 2010 упрощает и ускоряет поиск команд для работы с размерами, 
предоставляя в ваше распоряжение панель инструментов Dimension 
(Размеры) (рис. 1). 
 

 
Рис. 1 



 

Создание размерного стиля. 
 

Для создания размерного стиля щелкните на пиктограмме Dimension 
Style (размерные стили). Появилось диалоговое окно (рис. 2). 
 

 
 

Рис. 2 
В списке Styles выберите один из существующих размерных стилей, 

параметры которого вы хотели бы использовать в качестве отправной 
точки при создании нового стиля (например, размерный стиль, 
установленный по умолчанию, который называется ISO-25). 

Щелкните на кнопке New (Новый), чтобы создать новый размерный 
стиль как копию уже существующего стиля. Появится диалоговое окно 
Create New Dimension Style (Создание нового размерного стиля) (рис. 3). 
 
 
 
 
 
 
 
 

 
Рис.3 



 

 
 
В текстовом поле New Style Name введите имя нового стиля и щелкни- 

те на кнопке Continue (Продолжить). Появится диалоговое окно New 
Dimension Style (Новый размерный стиль) (рис. 4), которое содержит 6 
разделов и аналогично диалоговому окну Modify Dimension Style (Изменение 
размерного стиля), вызываемому щелчком на кнопке Modify. 

 
Рис. 4 

Активизируйте вкладку Lines (Линии). В этом разделе можно 
изменить следующие параметры: 

- Dimension lines (Размерные линии). 
Цвет размерной линии устанавливается в поле Color (Цвет). При ис- 

пользовании слоев цвет устанавливается ByLayer (По слою). 
Толщина размерной линии устанавливается в поле Lineweight 

(Толщина). При использовании слоев толщина устанавливается ByLayer (По 
слою). 



 

В случае, когда вместо стрелок используются засечки, значение в поле 
Extend beyond ticks (Удлинение за выносные ) определяет, насколько 
будет выступать размерная линия за выносные. 

При создании размера от общей базы расстояние между соседними 
линиями размерной цепи следует установить в поле Baseline spacing (Шаг в 
базовых размерах).Для данного занятия установите значение 7 

- Extension Line (Выносные линии). 
Чтобы продлить выносные линии на некоторое расстояние за пределы 

размерной необходимо установить это расстояние в поле Extend beyond dim 
lines. 

Величина отступа выносных линий от объекта устанавливается в поле 
Offset from origin (Отступ от объекта). Для данного занятия установите 
значение 0. 

Далее активизируйте вкладку Symbols and Arrows (Символы и 
стрелки) 
 Размер стрелки задается в поле Arrow size 
- Center Marks (Маркер центра ). В поле Type выбирается тип маркера и 
задается нужный размер. 
Активизируйте вкладку Text (Текст) (рис.5). 

В этом разделе можно изменить следующие параметры: 
- в поле Text Style можно определить стиль размерного текста; 
- поле Text Color позволяет выбрать цвет текста; 
- в поле Text height можно установить высоту размерного текста; 
- в поле Vertical можно определить поперечное расположение текста 

относительно размерной линии. Для данного занятия необходимо выбрать 
опцию Above (Располагает текст над размерной линией); 

- в поле Horizontal можно определить продольное расположение тек- 
ста относительно размерной линии. Для данного занятия необходимо вы- 
брать опцию Centered (Располагает текст по центру); 

- в поле Offset from dim line можно установить зазор между текстом и 
размерной линией; 
- в области Text Alignment можно определить ориентацию текста. 

Для данного занятия необходимо выбрать опцию Aligned with 
dimension line 
(Располагает текст параллельно размерной линии). 

В ситуации, когда размерный текст и стрелки не помещаются между 
выносными линиями, предлагается несколько вариантов решения этой 
проблемы с помощью вкладки Fit. 
 



 

 
 
Настройка основных единиц размерного числа осуществляется на 

вкладке Primary Units (Основные единицы). Здесь же задается масштабный 
фактор значения размера (В области Measurement Scale). 

Настройка альтернативных единиц размерного числа осуществляется 
на вкладке Alternate Units (Альтернативные единицы). 

Выполнение настроек допусков предельных отклонений производится 
на вкладке Tolerances (Допуски). 
 

Нанесение базовых размеров. 

Из панели инструментов Dimension выберите Linear Dimension 
(Линейный размер). 

Запрос: Specify first extension line origin or <select object>: (Начало 
первой выносной линии или <выбрать объект>: 

Рис.5 



 

- Установите точку 1 (рис. 6). 
Запрос: Specify second extension line origin: (Начало второй выносной 

линии: ) - Установите точку 2. 
Запрос: Specify dimension line location or [Mtext / Text / Angle / 

Horizontal/ Vertical / Rotated]: (Местоположение размерной линииили 
(Мтекст /Текст / Угол / Горизонтальный / Вертикальный / Повернутый:) 

Укажите точку расположения размерной линии. (По мере того как 
будет двигаться мышь, вы будете видеть на экране результат). Если нужно 
точно указать местоположение, можно ввести соответствующие 
относительные координаты (например @0, -10). В зависимости от 
содержания чертежа эту работу может облегчить использование шаговой 
привязки. 

 
Рис.6 

 
Нанесение размерных цепей. 

 
Из панели инструментов Dimension выберите Continued 

Dimension ( цепь). 
Запрос: Specify a second extension line origin or (<select>/ Undo): 

(Начало второй выносной линии или [оТменить/Выбрать] <Выбрать>: ). 
- Укажите точку 3 (см. рис. 6). 

Для окончания выполнения команды дважды нажмите клавишу Enter. 
 

Размеры от общей базы. 
 



 

На данном этапе мы будем устанавливать точки 4, 5, 6 (см. рис. 6). 
Из панели инструментов Dimension выберите Linear Dimension. 

Запрос: Specify first extension line origin or <select object>: (Начало 
первой выносной линии или [оТменить/Выбрать] <Выбрать>:) - Установите 
точку 4. 

Запрос: Specify second extension line origin: (Начало второй выносной 
линии или [оТменить/Выбрать] <Выбрать>: ) - Установите точку 5. 

Запрос: Specify dimension line location or [Mtext / Text / Angle / 
Horizontal/ Vertical / Rotated]: (Точно установите местоположение размерной 
линии или (Мтекст / Текст / Угол / Горизонтальный / Вертикальный / Повер- 
нутый). - Укажите точку расположения размерной линии. Нажмите Enter. 
Выберите Base line Dimension. 

Запрос: Specify a second extension line origin or 
(<select>/ Undo): (Начало первой выносной линии или [оТменить/Выбрать] 
<Выбрать>:). - Укажите точку 6. 

Запрос: Specify a second extension line origin or (<select>/ Undo): 
(Начало второй выносной линии или [оТменить/Выбрать] <Выбрать>: 
- Укажите точку 7. 

Для окончания выполнения команды дважды нажмите клавишу Enter. 
Самостоятельно установите недостающие линейные размеры. 
 

Нанесение размера радиуса сопряжения. 

Чтобы проставить на чертеже радиус, нужно щелкнуть на  
пиктограмме Radius  ( радиус) на панели инструментов Dimension. 

Запрос: Select arc or circle: (Укажите дугу или окружность:). - Выде- 
лите нужную дугу. 

Запрос: Specify dimension line location or <Mtext / Text / Angle>: 
(Положение размерной линии или [Мтекст/Текст/Угол]:). - Укажите, где 
именно должна появиться размерная линия. 
 

Редактирование размеров. 
Для редактирования размеров используются следующие команды: 

- DimEdit (Редактировать размер); 
- DimtEdit (Редактировать текст); 
- DimStyle (Размерный стиль). 

Проставьте линейный размер для точек 1* и 2* (см. рис. 6). 
Щелкните на пиктограмме Dimension Edit (Редактировать размер) панели 
инструментов Dimension. 



 

Запрос: Enter type of dimension [Home / New / Rotate / Oblique 
<Home>]: (Введите тип размера [Вернуть / Новый / Повернуть / Наклонить] 
:). - Введите N и нажмите Enter. 

 
Откроется диалоговое окно Text Formating . В списке Symbol (Символ)

 выберите Diameter (Диаметр) и щелкните OK. 
Запрос: Select object: (Выберите объекты:). – Выберите последний 

нанесенный размер и нажмите Enter. 
Самостоятельно проставьте диаметр малого отверстия. 
Изображение на дисплее должно соответствовать рис. 7. 

 
Рис.7 

Нанесение угловых размеров. 
 

Чтобы нанести на чертеж угловой размер, необходимо щелкнуть на 
пиктограмме Angular (Угловой ) панели инструментов Dimension. 
Система ответит запросом: Select arc, circle, line, or <specify vertex>: 
(Выберите дугу, круг, отрезок или <указать вершину>:). 

Дальнейшие запросы будут определяться тем, какой именно объект 
выбран. 

Если в ответ на первый запрос нажать клавишу Enter, то AutoCAD за- 
просит вершину угла, первую и вторую конечные точки угла. Этими тремя 
точками и задается угол. 

Если указать дугу, то AutoCAD проставит угловой размер дуги, ис- 
пользуя в качестве вершины угла центр дуги. 

Если указать окружность, то AutoCAD использует точку, которую при 



 

этом указали, в качестве первой конечной точки угла, а центр окружности 
– в качестве вершины угла. Затем необходимо указать точку на окружности. 

Если указать отрезок, то AutoCAD попросит указать вторую линию.  
В этом случае система измеряет угол между двумя линиями. 

Вопросы для самоконтроля 
 

1. В каком меню находятся команды нанесения размеров? 
2. Какие три действия необходимо выполнить на этапе подготовки к 
нанесению размеров? 
3. В каком меню находится команда Dimstyle? 
4. В какой области устанавливается расстояние между соседними 
линиями в размере от общей базы ? 
5. В какой вкладке можно указать расположение текста? 
6. В какой вкладке можно выбрать форматы представления основ- 
ных и альтернативных единиц? 
7. С помощью какой команды можно проставить линейный размер? 
8. Как проставить размер от общей базы? 
9. С помощью какой команды наносится размерная цепь? 
10. Как проставить радиальный размер? 
11. Какие команды редактирования размеров Вы знаете? 
12. С помощью какой команды редактируется текст размерной над- 
писи? 

Практическое задание 
 

Нанесите размеры на рисунки, выполненные в задании к практической. 
Работе № 3. 

 
 
 
 
 
 
 
 
 
 
 



 

Практическая работа № 5 
 

РЕДАКТИРОВАНИЕ ЧЕРТЕЖЕЙ. 

  
Цель занятия. 

 
Приобретение практических навыков в использовании основных команд 
редактирования чертежей AutoCAD 2010: Array (Массив), Copy (Копировать), 
Move (Перенести), Rotate (Повернуть). 
 

Порядок выполнения. 
 

Практическая работа состоит в последовательном интерактивном диалоге с 
системой для выполнения следующих действий: 
- создания файла рисунка; 
- упражнения по использовании команд Array, Copy, Move, Rotate. 
 

Стили редактирования. 
 

В AutoCAD применяются два основных стиля редактирования: с 
первоначальным заданием команды и с предварительным формированием 
множества выбора. После предварительного формирования множества 
выбора у вас появляются дополнительные возможности редактирования 
объектов – либо с помощью специальных команд, либо с помощью 
непосредственной манипуляции объектами на экране, не прибегая к 
именованным командам. 

Во время редактирования с первоначальным заданием команды вы 
вводите имя команды, а затем выбираете объекты, которые с помощью 
этой команды необходимо отредактировать. 

Применяя стиль редактирования с предварительным формированием 
множества выбора, вы осуществляете обычные операции и в том же по- 
рядке, как вы привыкли делать в Windows-совместимых приложениях, в 
типичных текстовых процессорах или программах рисования: вначале 
выбираете объекты, а затем команду для их обработки. 

Команды AutoCAD позволяют вносить в чертеж различные изменения. 
Система имеет большой набор средств редактирования, которые позволяют: 
- удалять примитивы по одному или группами; 
- восстанавливать  случайно  стертые  фрагменты;



 

 
- перемещать, поворачивать изображение или его элементы; 
- копировать и расставлять объекты на чертеже; 
- изменять масштаб чертежа или отдельных элементов; 
- сопрягать отрезки линий дугами произвольного радиуса, строить фаски; 
- строить зеркальное отображение; 
- отсекать часть примитива и удалять его; 
- выполнять деление отрезков, дуг и окружностей на равные части; 
- проводить линии на заданном расстоянии относительно других; 
- изменять свойства примитива; 
- и другие. 
 

Создание файла рисунка. 
 

Запустите AutoCAD. Создайте новый файл. Выберите метрические 
единицы. 

Включите объектные привязки Endpoint, Center, Intersection. 
Установите параметры вспомогательной сетки и шага равными 5 мм. 

 
Упражнение. 

 
С помощью команды Circle (Круг) начертите 4 круга с центром в 

точке с координатами 200,150 и с диаметрами 120, 85, 55 и 30 мм.  
С помощью команды Polygon (Многоугольник) построим 

многоугольник, вписанный в круг большего радиуса. 
Щелкните на пиктограмме Polygon панели инструментов Draw. 

Запрос: Enter number of sides <4>: (Введите количество сторон <4>:). 
– Наберите 10 и нажмите Enter. 
Запрос: Specify center of polygon or [Edge]: (Точно укажите центр мно- 
гоугольника или [Сторона]: ). – С помощью привязки к центру укажите 
центр круга. 
Запрос: Enter an option [Inscribed in circle / Circumscribed about circle] 
<I>: (Введите опцию [Вписанный в круг / Описанный вокруг круга]<В>:). - 
Наберите I и Enter. 
Запрос: Specify radius of circle: (укажите радиус круга:). - Наберите 60 и 
нажмите Enter. (Если это необходимо, увеличьте изображение.) 

С помощью команды Line постройте две осевые линии, проходящие 
через центр круга и выступающие за его пределы на 5 мм (используйте 
привязку к шагу сетки Snap). 



 

 
Изображение на дисплее должно соответствовать рис. 1.  
 

 
Рис.1 

 
Команда Rotate (Повернуть). AutoCAD позволяет легко поворачивать объект 

или объекты вокруг базовой точки на заданный угол. Для поворота 
достаточно щелкнуть на пиктограмме Rotate на панели инструментов Modify. 

Запрос: Select Objects. - Выберите многоугольник (см. рис. 1) и 
нажмите Enter. 

Запрос: Specify base point: ( базовая точка:). - Выберите центр круга с 
помощью привязки к центру. 

Запрос: Specify rotation angle or [Reference]: (Угол поворота или 
[Копия/Опорный угол] <0>).- Введите 90 и нажмите Enter. 

На пересечении осевых линий и кругов с радиусами 55 и 85 мм 
постройте два круга с радиусами 5 и 10 мм соответственно (для нахождения 
центра используйте привязку к пересечению). 

 Изображение на дисплее должно соответствовать рис. 2. 
 



 

 
 

Рис.2 
 

С помощью команды Trim (Обрезать) удалим часть круга, 

отмеченную на рис. 2 трелкой.   Команда Array  (Массив) копирует 
выбранные объекты столько раз, сколько укажет пользователь, и располагает 
их в форм прямоугольного или кругового массива. Эта команда является 
достаточно мощным и удобным средством создания чертежей сложных 
регулярных конструкций (например печатных плат). 

Щелкните на пиктограмме Array панели инструментов Modify. 
Появится диалоговое окно Array (Массив) (рис. 3). 

Установите переключатель Polar Array (Круговой массив). 
Щелкните мышью на кнопке Select Objects (Выберите объекты). 
Запрос: Select Objects: (Выберите объекты:). – Выберите круг с 

радиусом 10 мм и нажмите Enter. 
В диалоговом окне Array щелкните на кнопке Pick center point (Выбор 

центральной точки). 
 
 



 

 
 

Рис.3 
 
Запрос: Specify center point of array: ( укажите центральную точку 

массива – Укажите центр большого круга . 
В диалоговом окне Array в окошке Total number of items (Общее число 

элементов) введите число 10 и щелкните OK. 
Самостоятельно постройте круговой массив из кругов с радиусом 5мм 

с тем же центром, но с количеством элементов равным 5. 
Удалите осевые линии с помощью команды Erase. 
 Изображение на дисплее должно соответствовать рис. 4. 

 

 
Рис.4 

 



 

Команда Copy (Копировать) имеет опцию Multiplе (Несколько), 
позволяющую создавать любое количество копий одного или нескольких 
объектов. Есть два способа выполнения команды. 

Способ перемещения.  
В ответ на приглашение Specify base point or[Displacement/mode]< 

Displacement>: Базовая точка или [Перемещение/реЖим] <Перемещение>:) 
можно ввести сдвиг в виде смещения координат точки, в которую будет 
скопирован объект. Слово «перемещение» уже подразумевает относительный 
характер уточняющего параметра, поэтому символ @ при задании координат 
не используется. AutoCAD ответит запросом: Specify second point or <use first 
point as displacement>: (Укажите вторую точку или [Выход/Отменить] 
<Выход>:).Так как вся необходимая информация уже введена, то для 
копирования объекта достаточнонажать Enter. 

Способ «базовая точка / вторая точка».  
       На запрос Specify base point or[Displacement/mode]< Displacement>:) 
(Базовая точка или [Перемещение/реЖим] <Перемещение>:) можно указать 
базовую точку в любом месте чертежа. В ответ на запрос Specify 
second point of displacement: (Точно укажите вторую точку смещения:) 
нужно определить расстояние и угол поворота или указать вторую точку. 
     Создадим несколько копий нашего рисунка. Щелкните на пиктограмме 
Copy на панели инструментов Modify. 

Запрос: Select Objects: (Выберите объекты:). - Выберите рисунок, 
используя рамку выбора, и нажмите Enter. 

Запрос: Specify base point or[Displacement/mode]< Displacement>:) 
 (Базовая точка или [Перемещение/реЖим] <Перемещение>:). - Укажите 
центр большого круга (см. рис. 4) с помощью привязки к центру. 

Запрос: Specify second point or <use first point as displacement>: 
(Укажите вторую точку или [Выход/Отменить] <Выход>:) 

 - Укажите точки с координатами 325,150 и 75,150. 
  
Изображение на дисплее должно соответствовать рис. 5. 



 

 
 

Рис.5 
 
Команда Move (Перенести). Процесс переноса похож на процесс 
копирования. Отличие заключается в том, что AutoCAD при переносе не соз- 
дает копию, а переносит объект из его исходного положения. 
Щелкните на пиктограмме Move. 
Запрос: Select Objects: (Выберите объекты:).- Выберите средний рисунок и 
нажмите Enter. 
Запрос: Specify base point or displacement: (Базовая точка или [Перемещение] 
<Перемещение>:) -Укажите центр большого круга с помощью привязки к 
центру. 
Запрос: Specify second point or <use first point as displacement>: (Вторая точка 
или <считать перемещением первую точку>:)- Наберите 200, 80 и Enter. 
Самостоятельно создайте еще одну копию рисунка с координатами 
второй точки смещения 200,220. 
Построим прямоугольник, имитирующий поверхность стола. 
Щелкните на пиктограмме Rectangle панели инструментов Draw. 

Запрос: Specify first corner point or [Chemfer / Elevation / Fillet / 
Thickness/ Width]: (Точно укажите точку первого угла или [Фаска / Уровень / 
Сопряжение/ Толщина / Высота]:). – Наберите 5,10 и нажмите Enter. 
Запрос: Specify other corner point or [Area/Dimension/Rotation]: (Второй угол 
или [Площадь/Размеры/поВорот]: 

– Наберите 395,290 и нажмите Enter. 
Изображение на дисплее должно соответствовать рис. 6. 



 

 
Рис.6 

 

Вопросы для самоконтроля 
 
1. Какие стили редактирования вы знаете? 
2. Какие изменения позволяют вносить в чертеж команды редактирования? 
3. Какая команда позволяет создать набор регулярно расположенных 
объектов? 
4. Какие режимы выполнения команды вы знаете? 
5. Как осуществить копирование набора объектов? 
6. Можно ли создать несколько копий? 
7. Какая команда обеспечивает перенос набора объектов? 
8. Какие режимы работы команды Move вы знаете? 
9. Какая команда обеспечивает поворот набора объектов? 

 
 
 
 
 
 
 
 



 

Практическое задание 

 

                    Вариант 1.                                            Вариант 2. 

 

                        Вариант 3.                                          Вариант 4. 

 



 

               Вариант 5.                                                  Вариант 6. 

 

                  Вариант 7.                                      Вариант 8. 

 

                                   

                                                      Вариант9.



Практическая работа  № 6 
 

СОЗДАНИЕ ШАБЛОНА ЧЕРТЕЖА. 

  

Цель занятия. 

Приобретение практических навыков в работе с шаблонами и 
формировании текста. Создание шаблона титульного блока.  

 

Порядок выполнения. 

Практическая работа заключается в последовательной реализации 
нижеследующего интерактивного диалога с системой 
автоматизированного проектирования AutoCAD  и выполнении 
индивидуального задания. 

Использование стандартного шаблона при создании 

нового чертежа. 
 

Шаблон чертежа – тип графического файла. В системе AutoCAD он 
играет ту же роль, что и шаблон текстового процессора  (например в 
Microsoft Word). 

Из меню File (Файл) выберите New (Новый).В раскрывающемся 
списке Select template (Выберите шаблон).Выберите файл Acadiso.dwt. 

Создание собственного шаблона на базе открытого 

шаблона чертежа. 
 

Создадим шаблон на базе Acadiso.dwt, который должен содержать: 
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- параметры настройки чертежа (формат А4 (210, 297), единицы, 
точность); 

- титульный блок – рамка с заготовкой основной надписи; 
- необходимые текстовые и размерные стили. 
Рамку  и основную надпись начертите с помощью команды Polyline 

(Полилиния), которая находится на панели инструментов Draw. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                                        Рис. 1 
Команда Polyline (Полилиния). Рассмотрим один из самых 
интересных объектов AutoCAD  - двумерную полилинию. Мы в 
предыдущих работах пользовались командой Polyline,но не описывали ее 
подробно. Полилиния представляет собой объект, состоящий из списка 
вершин переменной длины, который отображается на экране как 
совокупность линейных сегментов и дуг. В отличие от команды Line, 
полилиния обладает шириной, которая позволяет чертить линии и дуги 
разной ширины, причем начальная и конечная ширина может быть разной. 
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При использовании полилиний гарантируется создание замкнутого 
контура. Полилиния, даже состоящая из 100 сегментов, воспринимается 
AutoCAD  как один объект.  

Для вычерчивания полилинии  щелкните на пиктограмме Polyline панели 
инструментов Draw.  

Запрос: Specify start point: (Начальная точка:). -Набираем 20,5 Enter. 

Запрос: Specify next point or [Arc/Halfwidth/Length/Undo/Width]: 
(Следующая точка или [Дуга/Полуширина/длИна/Отменить/Ширина]:)  -  
Наберите W и нажмите Enter. 

 Запрос: Specify starting width <0.0000>: (Начальная ширина 
<0.0000>). -  Наберите 0.8 и нажмите Enter. 

Запрос: Specify ending width <0.8000>: (Конечная ширина<0.8000>). -  
Нажмите Enter. 

Запрос: Specify next point or [Arc / Halfwidth / Length / Undo / Width]: 
(Следующая точка или [Дуга/Полуширина/длИна/Отменить/Ширина]).  -  
Наберите 205,5 и нажмите Enter. 

Запрос: Specify next point or [Arc / Close / Halfwidth / Length / Undo / 
Width]: (Следующая точка или  [Дуга/ Замкнуть/ Полуширина / длИна/ 
Отменить/ Ширина]).  -  Наберите 205,292 и нажмите Enter. 

Запрос: Specify next point or [Arc / Close / Halfwidth / Length / Undo / 
Width]: (Следующая точка или  [Дуга/ Замкнуть/ Полуширина / длИна/ 
Отменить/ Ширина]).  -  Наберите С  и нажмите Enter. 

Самостоятельно начертите основную надпись по размерам указанным 
на рис. 2 

Формирование и  редактирование текста. 
 

Текст в AutoCAD – это объект, имеющий характерные свойства, такие, 
как: точка вставки текстовой строки, высота текста, угол поворота, стиль 
(т.е. шрифт с его видоизменением), способ выравнивания и собственно 
текст. Для формирования текста в AutoCAD  применяется 3 команды: 
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 Dtext (Single Line Text(Однострочный), Text (Текст), Mtext (Multiline 
Text(Многострочный)). 

 По команде Dtext формируется динамический текст, т.е. текст, 
отображающийся на экране по мере его набора с клавиатуры. Команда 
Dtext запрашивает следующие текстовые строки после ввода первой. 

 Команда Text отличается от команды Dtext двумя особенностями: 

- символы не отображаются на экране до окончания работы с текстом 
и нажатия клавиши Enter; 

- команда Text  не выдает запроса на ввод очередной строки. Чтобы 
создать вторую строку, необходимо вновь запускать эту команду. 

Команда Mtext – Multiline Text (Многострочный текст). Однострочный 
текст становится неудобным, если нужно включить в чертеж достаточно 
длинную надпись. В данном случае применяется команда Mtext 

.

                                                          
Рис. 2 

 

Текстовые стили. 
Создание нового текстового стиля. Чтобы создать новый стиль текста, 
воспользуйтесь меню Format  Text Style (Формат  Стиль текста). Тем 
самым запускается команда Style (Стиль) и откроется диалоговое окно  
Text Style (Текстовые стили) (рис. 3). 
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Рис.3 

 Щелкните на кнопке New окна Text Style. Напечатайте имя нового 
стиля и щелкните на кнопке ОК. 

 В зоне Font (Шрифт) указывается шрифт, его начертание и высота. 
Установите шрифт txt,  высоту 3.5. 

 В зоне Effects (Эффекты) можно указать ориентацию, ширину и 
наклон гарнитуры шрифта. Oblique angle  (Угол наклона) установим 15 
(так как текст, буквы в котором стоят прямо, имеет угол наклона 0°). 

 Из меню Draw стандартной панели инструментов выберите команду 
Text  Single Line Text (Однострочный текст). 

Запрос: Specify start point of text or [Justify / Style]: (Начальная точка 
текста или [Выравнивание/Стиль]:).- Введите j  Enter. 

Запрос: Enter an option 
[Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR]:  (Задайте 
параметр  [впИсаный/ Поширине/ Центр/ сЕредина/ впРаво/ ВЛ/ ВЦ/ ВП/ 
СЛ/ СЦ/СП/НЛ/НЦ/НП]:).  -  Введите F  Enter. 

Укажите начальную и конечную точки текстовой строки  напечатайте 
необходимый текст и дважды нажмите Enter. 
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Редактирование однострочного текста. Для редактирования текстовой 
строки существуют несколько способов:  

использование команды Ddedit (Диалред). В меню Modify выберите 
Object  Text Edit . 

Запрос: <Select an annotation object> / Undo: (Выберите объект-
аннотацию или [Отменить]:). - Выберите редактируемый текст. AutoCAD 
откроет диалоговое окно Edit Text (Редактирование текста). Введите 
изменения и щелкните ОК; 

 - использование диалогового окна Properties (Свойства). Откройте 
диалоговое окно Properties (), выберите любой тестовый объект и 
посмотрите на таблицу в окне. Здесь можно редактировать не только 
содержание текста, но также всевозможные  свойства: слой, содержание, 
стиль и др. 

Те значения, которые не приглушены, вы можете изменять прямо в 
таблице и фиксировать изменения клавишей Enter, после этого текст на 
экране сразу поменяется, и вы можете оценить полученный результат. 

- редактирование с помощью ручек. При выборе объектов в режиме 
ожидания команды объекты подсвечиваются, а в характерных точках 
появляются квадратные значки – это и есть ручки. 
Щелкните на одной из ручек, чтобы сделать ее активной (при этом 
включается режим растягивания). Так как в нашем случае текст при 
создании выравнивался опцией Fit (По ширине), то строки имеют по две 
ручки и мы без труда можем поворачивать, сжимать или растягивать 
каждую строку. Выравнивание текста по одной из крайних точек приведет 
к появлению по одной ручке в каждой строке. 

Порой приходится изменять способ выравнивания, не изменяя 
положения текстовых объектов. Для этих целей создана новая команда 
JUSTIFYTEXT (Выровнитекст). После выбора текстовых объектов 
AutoCAD предлагает выбрать другой способ выравнивания из перечня 
опций. 

 

Рис. 4 
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-  

 Рис.4 

 

Размерный стиль. 

 

Для создания размерного стиля щелкните на пиктограмме Dimention 
Style (о создании размерного стиля смотри в практ. работе № 4). 
Напечатайте имя размерного стиля и внесите изменения, соблюдая 
нижеследующие правила нанесения размеров.  

         Размеры на чертежах указывают размерными числами и размерными 
линиями. Размерная линия располагается на расстоянии не менее 10 мм от 
контура детали. 
Она  ограничивается  с  двух  сторон  стрелкой. Величина стрелки – 2,5 мм. 
Выносные линии выходят за концы стрелок размерной линии на 1…5 мм. 
Над размерной линией, ближе к ее середине, наносят размерное число. 
Если на чертеже несколько размерных линий, параллельных друг другу, то 
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ближе к изображению наносят меньший размер. Расстояние между 
параллельными размерными линиями должно быть не меньше 7 мм. 

 После внесения изменений щелкните на кнопке Save диалогового 
окна Dimention style. 

Если все параметры введены, щелкните на пиктограмме Save As 
(Сохранить как), стандартной панели инструментов.  

В диалоговом окне Save Drawing as (Сохранить рисунок как) (рис. 5) 
раскройте список файлов Files of type (Тип файла) и выберите в нем 
AutoCAD Drawing Template (*.dwt) (Файл шаблона чертежа). В поле File 
name (Имя файла) введите имя нового шаблона и щелкните на кнопке Save 
(Сохранить). 

 При выборе имени  для нового файла постарайтесь, чтобы оно ясно 
говорило о назначении шаблона и не перекликалось с именами чертежей, 
например, tb-0.dwt, tb-1.dwt и т.д. (tb означает Title block – Титульный 
блок). 

 
 

Рис. 5 
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  Вопросы для самоконтроля 
 

1. Какую опцию из списка Select how to begin нужно выбрать, чтобы 
открыть новый чертеж на базе существующего шаблона? 

2. Как создать собственный шаблон на базе открытого? 
3. Что должен содержать шаблон чертежа? 
4. Какие команды AutoCAD применяются для формирования текста? 
5. Какие отличия существуют между командами формирования 

текста? 
6. В каком меню находится команда Text Style и для чего она 

предназначена? 
7. В какой зоне указывается шрифт, его начертание и высота? 
8. Что указывается в зоне Effects? 
9. Какая опция команды Dtext используется для создания текста, 

вписанного в ограниченную область без изменения высоты 
шрифта? 
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Практическое задание 
Используя созданный шаблон, выполнить следующий чертеж. 
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 ЧАСТЬ 2. ТРЕХМЕРНОЕ МОДЕЛИРОВАНИЕ. 

Практическая работа № 1 
 

ПОСТРОЕНИЕ ЧЕРТЕЖЕЙ ТРЕХМЕРНЫХ МОДЕЛЕЙ 

 

Цель занятия 

Приобретение практических навыков в создании и редактировании 
трехмерных каркасных моделей и поверхностей. Использование 
команды Elev для создания трехмерных объектов. 

Порядок выполнения 
 

Практическая работа заключается в последовательной реализации 
нижеследующего интерактивного диалога с системой 
автоматизированного проектирования AutoCAD  и выполнении 
индивидуального задания. 

Ввод трехмерных координат 
 

Все способы ввода двухмерных координат имеют свои трехмерные 
аналоги. Если раньше линия задавалась путем ввода координат начальной 
(3, 4) и конечной точки (5, 7), то теперь можно задать трехмерную линию, 
определив ее начальную точку (3, 4, 2) и конечную точку (5, 7, 6). 
Абсолютные координаты в трехмерных чертежах такие же, только 
добавляется координата Z. Точно так же определяются и относительные 
координаты. 

В работе с трехмерными чертежами можно использовать два новых 
типа координат – цилиндрические и сферические, которые являются 
трехмерными аналогами полярных координат. 

 Большинство команд, используемых для построения двухмерных 
чертежей, воспринимают трехмерные координаты только для первой 
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точки. После чего координата Z опускается, и считается, что она одинакова 
для всех точек 

Например, при вводе прямоугольника координаты первого угла можно 
определить как 2, 3, 8,  но уже второй угол должен быть задан без Z, т.е. 6, 
7. Значение Z для остальных точек устанавливается равным 8. Команда 
Line – исключение. Это истинно трехмерная команда, поэтому 
указываются все три координаты X, Y и Z для каждой точки.   

Цилиндрические и сферические координаты. Цилиндрические 
координаты имеют формат расстояние < угол, расстояние (для 
абсолютных координат) или @ расстояние < угол, расстояние (для 
относительных координат). Первое расстояние – длина проекции на 
плоскость XY вектора, начинающегося в начале координат (для 
абсолютных координат) или в последней введенной точке (для 
относительных координат). Угол отсчитывается от оси X в плоскости XY. 
Второе расстояние равно числу единиц вдоль оси Z. На рис. 1 показан 
отрезок, вычерченный в цилиндрических координатах. 

 

 

 

 

 

 

 

 

 

 

 
Рис.  1 
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0,0,0 

Ось Z 

@ 5 < 15<30 

Ось Y 
5 единиц 

300 в направлении Z 

  

150 в плоскости XY 

Сферические координаты имеют формат расстояние < угол < угол (в 
абсолютных координатах) или @ расстояние < угол < угол (в 
относительных координатах). Первое расстояние - длина вектора, 
начинающегося в начале координат (для абсолютных) или в последней 
введенной точке (для относительных координат). Первый угол 
отсчитывается от оси X в плоскости XY. Второй угол отсчитывается от 
плоскости XY в направлении оси Z. На рис. 2 показан отрезок, 
построенный с использованием сферических координат. 

 

 

 

 

 

 

 

 

 

 

 

 

Рис. 2 

 

Команды редактирования трехмерных каркасных моделей 
 

Некоторые команды редактирования двухмерных объектов хорошо 
работают и с трехмерными. Другие же имеют особые версии для работы с 
трехмерными объектами. Поскольку каркасные модели – это двухмерные 



 

82 

 

объекты, помещенные в трехмерное пространство, можно пользоваться 
знакомыми командами редактирования. 

Работа с трехмерными координатами 

 Загрузите файл Acad.dwt. Щелкните на пиктограмме инструментов 
Rectangle (Прямоугольник) на панели инструментов Home->Draw. 

Запрос: Specify first corner point or [Chamfer / Elevation / Fillet / Thickness / 
Width]: - Введите 0,0,20 и  Enter. 

Запрос: Specify other corner point or [Area/Dimensions/Rotation] - 
Введите 40, 15; Enter. 

Тем самым будет создан прямоугольник длиной 40 единиц и шириной 
15 единиц, который расположен на 20 единиц выше плоскости XY 
(обратите внимание, что для второго угла опущена координата Z). 
Щелкните на кнопке Zoom all (Покажи все) и Zoom out (Уменьшить). 

Выполните команду Copy, чтобы получить копию первоначального 
прямоугольника, расположенного на 2 единицы выше исходного. 

Запрос: Select objects (Выберите объекты). - Выберите прямоугольник. 
Запрос: Select objects (Выберите объекты). - Нажмите Enter. 
Запрос: Specify base point or [Displacement/mOde] <Displacement>: 

Введите 0,0,2; Enter. 
Запрос: Specify second point of displacement or <use first point as 

displacement> (Вторая точка смещения или <используйте первую точку как 
смещение>). - Нажмите Enter. 

Щелкните на пиктограмме SE Isometric View на панели инструментов 
View->Appearance->Views. Теперь видны оба прямоугольника (рис. 3). 

Установите текущую опцию объектной привязки Endpoint. Выполните 
команду Line, отвечая на запросы. 

Запрос: Specify first point (Точно укажите первую точку). - Укажите 
точку 1 (см. рис. 3). 

Запрос: Specify next point or [Undo]: (Точно укажите следующую точку 
или [Отмени]). - Введите 0, 0, 0;  Enter. 

Запрос: Specify next point or [Undo]: - Введите 1, 0, 0;  Enter. 
Запрос: Specify next point or [Close / Undo]: - Введите 1, 0, 21;  Enter. 
Запрос: Specify next point or [Close / Undo]: - Нажмите Enter. 

Выполните команду Copy. 
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с.2. Рис.2. 

 

Рис.3 

 
Запрос: Select objects: (Выберите объекты).- Укажите  три отрезка, 

которые только что начертили. Нажмите Enter. 
Запрос Specify base point or [Displacement/mOde] <Displacement>: 

Введите 39, 0, 0;  Enter. 
Запрос: Specify second point of displacement or <use first point as 
displacement> (Вторая точка смещения или <используйте первую 
точку как смещение>).  - Нажмите Enter. 
       Выполните команду Zoom Extents (Покажи границы), чтобы 
увидеть весь чертеж.  
 
Повторите команду Copy. Воспользуйтесь двумя отдельными 
рамками, чтобы выбрать первую ножку, а затем вторую. Закончите 
выбор. 

Запрос: Specify base point or [Displacement/mOde] <Displacement>: 
Введите 0, 15, 0;  Enter. 

Запрос: Specify second point of displacement or <use first point as 
displacement> (Вторая точка смещения или <используйте первую точку как 
смещение>). - Нажмите Enter. 

Изображение на дисплее должно соответствовать рис. 4. Сохраните 
рисунок. 

 

2 

3 
1 
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Рис. 4 

 

 

 

 

Рис.4 

 

Применение координатных фильтров и объектных привязок 

 при работе с трехмерными каркасными моделями 

 

Фильтры точек – это средство AutoCAD, которое позволяет создавать 
новую точку построения, комбинируя составляющие векторы координат 
существующих точек чертежа. Обычно координатные фильтры 
используются вместе с объектными привязками. Например, для ввода 
координаты X можно указать конечную точку линии. Часто координатные 
фильтры -  единственный способ определить трехмерную точку, которая 
лежит вне существующего объекта. Для работы с трехмерными чертежами 
используются следующие координатные фильтры:  .XY, .XZ, .YZ. 
Например, если нужно выбрать точку, лежащую на 3 единицы в 
направлении Z от конечной точки существующей линии, можно 
воспользоваться фильтром .XY и выбрать конечную точку линии. Затем 
последует запрос относительно координаты Z, которую можно определить 
как число, либо привязаться к объекту. 

Построение трехмерных поверхностей 

У поверхностных моделей большое преимущество перед каркасными 
моделями: они могут закрывать объекты позади себя и отбрасывать тень.  

1 

2 
3 
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Методы поверхностного моделирования позволяют создавать вполне 
реалистические изображения объектов нерегулярной формы. Однако 
информацию относительно физических свойств объекта – его массы, 
центра тяжести и тому подобных – из поверхностных моделей получить 
нельзя.   

При работе с поверхностями удобно пользоваться панелью 
инструментов Home->Build.  (рис.5) 

 

Рис.5 
 

Построение типовых трехмерных фигур 

Чтобы построить фигуру сначала необходимо выбрать ее тип из 

ниспадающего списка панели Home->Build:   

Параллелепипед. Щелкните на пиктограмме Box (Ящик). 
Запрос: First Corner or [SHape]: Наберите 1,7; Enter. 
Запрос: Second Corner or [SHape/Undo]: Наберите 5,5; Enter. 
Запрос: Height or [SHape/Undo]: Наберите 5; Enter. 
Запрос: Rotation or [SHape/Undo] <0.00>: Наберите 0; Enter. 
 

Пирамида. Щелкните на пиктограмме Pyramid панели Surfaces. 
Запрос: First Corner or [SHape]: Наберите 4,7; Enter. 
Запрос: Second Corner or [SHape/Undo]: Наберите 6,10; Enter. 
 Запрос: Height or [SHape/Undo]: Наберите 4; Enter. 
Запрос: Rotation or [SHape/Undo] <0.00>: Наберите 0; Enter. 
 
Конус. Щелкните на пиктограмме Cone (Конус). 
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Запрос: Insert point or [SHape]: Наберите 2,4.5; Enter. 
Запрос: Radius or [SHape/Undo]: Наберите 1; Enter. 
Запрос: Height or [SHape/Undo]: Наберите 5; Enter. 
Запрос: Rotation or [SHape/Undo] <0.00>: Наберите 0; Enter. 

 
Сфера. Чтобы построить сферу, задайте ее центр и радиус. 
Изображение на дисплее должно соответствовать рис. 6. 

 

 

 

 

 

 

 

 

 

Рис. 6 

Самостоятельно постройте остальные стандартные поверхности. 
 

Работа с уровнем и высотой 
AutoCAD может превращать большинство плоских объектов как бы в 
трёхмерные, наделяя их высотой. На самом деле объект в описании 
остаётся двухмерным,  имеющим ещё одно свойство, которое мы легко 
можем менять на протяжении всего времени работы с чертёжным файлом, 
в котором находится этот объект. Напоминаем, что высота объекта 
простирается в направлении оси Z системы координат, в которой был 
построен этот объект. Высоту объекта можно легко изменить в диалоговом 
окне   Properties. Чтобы установить текущее значение высоты, нужно из 
падающего меню Format выбрать строку Thickness и ввести с клавиатуры 
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значение высоты в ответ на предложение: New value for THICKNESS 
<0.0000>:f 

 

Рис.7 

Упражнение. 

Начните новый чертеж, используя Acad.dwt как шаблон. 

Выполните команду Circle. Определите центр с координатами (4, 6) и 
радиус 8. 

Выберите круг и щелкните на пиктограмме Properties на 
стандартной панели инструментов. В поле Thickness диалогового 
окна Properties введите новую высоту 1.  

Наберите Elev в командной строке. 

 Запрос: Specify new default elevation <0.0000> (Новый текущий 
уровень<0.0000>). - Введите 1. 

  Запрос: Specify new default  thickness <0.0000> (Новая текущая 
высота<0.0000>). - Введите 10. 
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Еще раз выполните команду Circle. Выберите привязку к центру и 
укажите центр сформированного круга как центр нового. Значение радиуса 
установите 1. 

Наберите Elev в командной строке Запрос: Specify  new default 
elevation <1.0000>. -  Введите 11. 

  Запрос: Specify new default thickness <10.0000>. - Введите 1. 

Тем самым все новые объекты будут помещены на верхнюю грань 
двух только, что сформированных объектов. 

Еще раз выполните команду Circle. Определите центр с координатами 
(4, 6) и радиус 8. Поскольку координата Z не задается в этой команде, 
будет использован текущий уровень. 

Щелкните на пиктограмме SE Isometric View на панели инструментов 
View point и наберите в командной строке Hide (Скрой). Теперь 
отчетливо видно изображение кабельной катушки (рис 8). 

 

Рис.8 

 
 

Вопросы для самоконтроля 
 

1. Какие трехмерные аналоги полярных координат и их форматы вы 
знаете? 

Рис. 8 
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2. Какие команды создания и редактирования двумерных объектов 
работают  и с трехмерными? 

3. Какие недостатки имеют каркасные модели? 
4. Какой панелью инструментов удобно пользоваться при работе с 

поверхностями? 
5. Какие типовые фигуры можно построить? 
6. Какой опцией необходимо воспользоваться, чтобы построить 

усеченную пирамиду? 
7. Как построить перевернутый конус? 
8. Для каких целей используется команда Elev? 

Практическое задание 
 

Выполните следующий рисунок. 
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Практическая работа № 2 

 
РАБОТА С ОБЪЕМНЫМИ ТЕЛАМИ 

 

Цель занятия 

Приобретение практических навыков в создании и редактировании 
объемных тел. Использование команды PLine для создания трехмерных 
объектов. 

Порядок выполнения 

Практическая работа заключается в последовательной реализации 
нижеследующего интерактивного диалога с системой 
автоматизированного проектирования AutoCAD  и выполнении 
индивидуального задания. 

Формирование стандартных твердотельных моделей 

 

Помимо создания двухмерных и поверхностных моделей, АutoСAD 
позволяет работать и с твердотельными моделями, которые наиболее 
полно отражают реальные свойства моделируемых объектов. Для работы с 
твердотельными моделями (телами) вам понадобится панель инструментов 
Solids (Тела) (рис. 1).  

 

 

Рис. 1 
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Отображение всех криволинейных поверхностей в чертеже 
регулируется с помощью системной переменной Isolines. Значение этой 
переменной по умолчанию равно 4.  

 
Формирование параллелепипеда.  Чтобы сформировать 

твердотельную модель – параллелепипед, выполните следующие 
операции: 

- щелкните на пиктограмме Box (Ящик)  панели инструментов Solids; 
- в ответ на приглашение Specify corner of box or [Center] <0,0,0>: 

(Точно укажите угол ящика или [Центр] <0,0,0>:) укажите вершину 
параллелепипеда (или введите Сe и воспользуйтесь опцией Center). При 
указании вершины появится запрос Specify corner or [Cube / Length] (Точно 
укажите угол или [Куб / Длина]:). По умолчанию выбирается 
противоположный угол на плоскости XY. Затем запрашивается высота по 
оси Z, и построение завершается. Если выбрали опцию Length (Длина),  то 
после задания длины AutoCAD запрашивает ширину и высоту. Если 
выбрали опцию Cube (Куб), то AutoCAD запрашивает только длину. При 
инициировании опции Center появится запрос: Specify center of box 
<0,0,0>: (Точно укажите центр ящика  <0,0,0>:), а затем запрос: Specify 
corner or [Cube / Length] (Точно укажите угол или [Куб / Длина] :). Если 
выбрали опцию Length,  то после задания длины AutoCAD запрашивает 
ширину и высоту. Если выбрали опцию Cube, то AutoCAD запрашивает 
только длину. 

Чтобы посмотреть результаты, щелкните на пиктограмме SE 
Isometric View (Изометрическая точка наблюдения) на панели 
инструментов View. 

Формирование шара. Щелкните на пиктограмме Sphere (Шар) панели 
инструментов Solids. 
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Запрос: Specify center of sphere <0,0,0>: (Центр шара<0,0,0>:). - 

Укажите центр шара. Если требуется, чтобы шар лежал на плоскости XY, 
то координата Z центра должна быть равна радиусу. 

Запрос: Specify radius of sphere or [Diameter]: (Точно введите радиус 
шара или [Диаметр]:). - Введите радиус шара (или воспользуйтесь опцией 
Диаметр). 

 
Построение цилиндра. Щелкните на пиктограмме Cylinder (Цилиндр) 
панели инструментов Solids. 

Запрос: Specify center point for base of cylinder or [Elliptical] <0,0,0>: 
(Точно введите центральную точку основания цилиндра или 
[Эллиптический] <0,0,0>). - Укажите центр основания или выберите 
опцию Elliptical. При указании центра появится запрос: Specify radius  for 
base of cylinder or [Diameter]. Укажите значение радиуса или выберите 
опцию Диаметр. При задании опции Elliptical появится стандартное 
приглашение команды Ellipse. 

Запрос: Specify height of cylinder or [Center of other end]: -  Укажите 
высоту цилиндра. 

 

Построение конуса. Конус можно построить с круговыми и 
эллиптическими основаниями.  

Щелкните на пиктограмме Cone (Конус) панели инструментов Solids. 

Запрос: Specify center point for base of cone or [Elliptical] <0,0,0>: 
(Точно введите центральную точку основания конуса или [Эллиптический] 
<0,0,0>). - Укажите центр основания для кругового конуса или выберите 
опцию Elliptical. 
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При указании центра появится приглашение Specify radius  for base of 
cone or [Diameter]. Укажите значение радиуса или выберите опцию 
Diameter. 

При задании опции Elliptical появится стандартное приглашение 
команды Ellipse. 

Запрос: Specify height of cone or [Apex] (Точно задайте высоту конуса 
или [Вершина]). - Укажите высоту или воспользуйтесь опцией Apex для 
указания вершины. 

 

 

Формирование клина. Щелкните на пиктограмме Wedge (Клин) панели 
инструментов Solids (Тела). 

В ответ на приглашение Specify corner of wedge or [Center] <0,0,0>: 
(Точно укажите угол клина или [Центр] <0,0,0>:) укажите вершину клина 
(или введите Сe и воспользуйтесь опцией Center). При указании вершины 
появится запрос Specify corner or [Cube / Length] (Точно укажите угол или 
[Куб / Длина] :). По умолчанию выбирается противоположный угол на 
плоскости XY. Затем запрашивается высота по оси Z, и построение 
завершается. Если выбрали опцию Length (Длина),  то после задания 
длины AutoCAD запрашивает ширину и высоту. Если выбрали опцию Cube 
(Куб), то AutoCAD запрашивает только длину. При инициировании опции 
Center появится запрос: Specify center of wedge <0,0,0>: (Точно укажите 
центр клина <0,0,0>:). А затем запрос: Specify corner or [Cube / Length] 
(Точно укажите угол или [Куб / Длина]:). Если выбрали опцию Length,  то 
после задания длины AutoCAD запрашивает ширину и высоту. Если 
выбрали опцию Cube, то AutoCAD запрашивает только длину.  

 

 
Формирование тора. Тор – это трехмерная «баранка». 

Щелкните на пиктограмме Torus (Тор) панели инструментов Solids. 
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Запрос: Specify center of torus<0,0,0. - Точно укажите центр тора. 

Запрос: Specify radius of torus or [Diameter]: (Точно введите радиус 
тора или [Диаметр]:). - Введите радиус тора (или воспользуйтесь опцией 
Диаметр). 

Запрос: Specify radius of tube or [Diameter]: (Точно введите радиус 
трубки или [Диаметр]:). - Введите радиус трубки (или воспользуйтесь 
опцией Диаметр). 

Самостоятельно постройте тор с RT  = 10,  RTР = 30 и RT  = -20, RTР  = 30, 
где RT – радиус тора; RTР – радиус трубки. 

Создание выдавленных тел 
Команда Extrude (Выдави) служит для создания выдавленных тел из 

замкнутых плоских объектов (профилей). Для выдавливания можно 
использовать замкнутые полилинии на плоскости, круги, эллипсы и т.д. 
Системная переменная Delobj определяет, будут ли сохраняться исходные 
объекты, используемые командой Extrude для создания тел. По умолчанию 
они удаляются (Delobj = 1). 

Упражнение 
Создадим объект с помощью команд Extrude (Выдави),  Subtract 

(Вычти), Union (Объедини). 
Откройте новый файл на базе Start from scratch, выберите метрические 

единицы. 
Постройте 4 круга с одним центром в точке 200,140 и с радиусами 

100, 80, 30 и 10 мм. 
Выдавите с помощью команды Extrude большие круги на высоту 60 

мм, а маленькие - на высоту 80 мм. 
Щелкните на пиктограмме Extrude панели инструментов Solids.  
Запрос: Select objec. - Выберите круги с радиусами 100 и 80 и нажмите 

Enter. 
Запрос: Specify height of extrusion or [Path]<0>: (Точно укажите 

высоту выдавливания или [Траектория]). – Наберите 60 и Enter. 
Запрос: Specify angle of taper for extrusion <0>: (Точно укажите угол 

сужения <0>:). – Enter. Аналогично выдавите малые круги. 
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Щелкните на кнопке команды Subtract на панели инструментов Solids 
Editing (Редактирование тел). 

Запрос: Select solids and regions to subtract from … select objects 
(Выберите тело  и области, из которых нужно вычесть … выберите 
объекты). - Выберите  цилиндр с R = 100. Нажмите Enter, чтобы закончить 
выбор объектов. 

Запрос: Select solids and regions to subtract … select object (Выберите 
тело  и области, которые будете вычитать, … выберите объекты). - 
Выберите цилиндр с радиусом 80 мм. Нажмите Enter. 
То же самое проделайте с внутренними цилиндрами. 

Чтобы посмотреть результаты, щелкните на пиктограмме SE Isometric 
View   на панели инструментов View. 

С помощью команды Union объединим эти два тела в одно.  
Из панели инструментов Solids Editing выберите Union 

(Объединение).  
 Запрос: Select objects: (Выберите объекты). - Выберите построенные 

объекты. Получили рис. 2.  
 
 

 

 

 

 

 

 

Рис. 2 

 

Разрезы и сечения тел 
  

2 

1 

4 

3 



 

96 

 

Разрезание тел. Выполните регенерацию, чтобы удалить скрытый 
вид (из меню View выберите Regen all). Включите режим объектной 
привязки Quadrant (Квадрант). 
 Щелкните на пиктограмме Slice (Разрез) панели 
инструментов Solids.  
        Запрос: Select objects. - Выберите твердотельную модель. Нажмите 
Enter, чтобы закончить выбор. 
           Запрос: Specify first point on slicing plane by [Object / Z axis / View / XY 
/ XZ / ZX /3 point] <3 point> (Точно укажите первую точку плоскости 
разреза по [Oбъект / ось Z / вид / XY / XZ / ZX / 3 точки <3 точки >). - 
Выберите квадрант 1 (см. рис. 2). 

Запрос: Specify second point on plane (Точно укажите вторую точку  на 
плоскости). - Выберите квадрант 2. 

Запрос: Specify third point on plane (Точно укажите третью точку на 
плоскости). - Выберите квадрант 3. 
        Запрос: Specify a point on desired side of the plan or [Both sides] / < >: 
(Точно укажите точку  на желательной стороне плоскости или [Обе 
стороны]). - Выберите квадрант 4. Выполните удаление невидимых линий. 

Изображение на дисплее должно соответствовать рис. 3. 
        Команда Section (Сечение) выполняется аналогично команде Slice. 
Желательно выполнять эту команду в текущем слое, цвет которого 
отличен от цвета объекта, чтобы область была отчетливо видна. 

Рис. 3 
 

Интересные возможности таит в 
себе опция Path (Траектория). При 
ее выборе построение 
твердотельного объекта начинается 
от профиля и развивается в 
направлении объекта, который 
выбирается в качестве 
направляющей линии. В 
зависимости от характера и 
местоположения направляющей 
линии, которая может быть 
замкнутой и незамкнутой, можно с 
одним и тем же профилем строить 
различные объекты 
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Упражнение  
 

Узел, показанный на рис. 4, образован перемещением окружности по 
весьма сложной траектории. Для построения узла необходимо решить две 
задачи: построить траекторию и преодолеть ограничения, предъявляемые 
командой Extrude к кривизне траектории. Траекторию построим как 
сплайн по 21 точке. 

Щелкните на пиктограмме Spline (Сплайн) панели инструментов Draw. В 
ответ на запрос вводите координаты точек согласно таблице. Завершите 
ввод, дважды нажав Enter. 

Таблица 

 

 

 

 

 

 

 

Рис. 4 

Проверьте полученный сплайн. Для этого выведите список 
координат вершин сплайна с помощью команды List (Список).  

Наберите в командной строке List и нажмите Enter. 

Запрос: Select objects: (Выберите объекты :). - Укажите сплайн и 
нажмите Enter. В текстовом окне будут выведены координаты точек 
сплайна. После сообщения Number of fit points: приведены координаты 
исходных точек сплайна. Сверьте их с данными таблицы.  

-62, 12, 0 30, -13, 0 
-30, 11, -5 15, 3, 10 
-13, 10, -10 0, 0, -10 
0, 12, 10 -7, -3, 0 
8, 15, 0 -11, 6, 10 
11, 6, -10 -8, 15, 0 
7, -3, 0 0, 12, -10 
0, 0, 10 13, 10, 10 
-18, 2, -10 30, 11, 5 
-30, -13, 0 62, 12, 0 
0, -35, 0  
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В случае выявления ошибки примените команду 
редактирования сплайна Splinedit (Редактирование сплайна), 
пиктограмма которой находится на панели инструментов Home->Modify.  

Построенную кривую не удается непосредственно применить в 
качестве траектории ввиду ограничений по кривизне линии со стороны 
команды Extrude(Выдави). Установлено, что ограничения существенно 
ниже, если линия представлена не сплайном, а пространственной 
полилинией (ломаной). Применим полученный сплайн в качестве основы 
для построения ломаной линии. Для этого проставим вдоль сплайна 
точки, а затем соединим их командой 3dpoly (3D Полилиния). 

Выберите из меню Format Point style (Стиль точки) 
и задайте маркер точки − прямой крестик. Установите 
размер маркера равным 1 %. 

Выберите из меню Home->Draw Point  Divide 
(Подели) 

Запрос: Select object to divide (Выберите объект для деления).- 
Выберите сплайн. 

Запрос: Enter the number of segment or [Block]: (Введите число 
сегментов или [Блок] :). - Задайте количество точек деления равным 130. 
Вдоль кривой равномерно по длине будут проставлены маркеры точек 
(Рис. 5) . 

Рис.5 
 

Установите постоянно действующую объектную привязку Node 
(Узел): Строка состояния ->Object Snap. 
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Увеличьте изображение левой части траектории так, чтобы 
уверенно различать точки. 

Выберите из меню Home->Draw 3D Polyline(3D 
Полилиния).  

Запрос: Specify start point of polyline: (Точно укажите 
начальную точку полилинии).- Укажите левый конечный маркер и далее 
соединяйте точки, указывая их при включенной объектной привязке. На 
участках малой кривизны можно пропускать точки. В основной части 
узла, где кривизна траектории высока, точки нужно соединить подряд без 
пропуска. Соединяя точки, панорамируйте изображение, не прерывая 
команду 3dpoly. 

Для панорамирования укажите кнопку  на стандартной панели 
инструментов. Указав последнюю точку, завершите ввод правым щелчком 
мыши или Enter. 

Создайте профиль выдавливания — окружность, установив ее в 
плоскости, перпендикулярной траектории в ее конечной точке. 

Для того чтобы задать плоскость профиля, 
выберите из меню View  Coordinates  Z Axis Vector. 
Укажите объектной привязкой левую конечную точку траектории и точку 
рядом с ней. 

Щелкните на пиктограмме Circle (Круг) и постройте круг с  центром 
в начале координат (0,0) и радиусом 3. 

Щелкните на пиктограмме Extrude (Выдави) на панели 
инструментов Solids (Тела). 

Запрос: Select objects: (Выберите объекты :). - Укажите профиль 
(Круг) Enter . 

 Запрос: Specify height of extrusion or [Path]: (Точно задайте высоту 
выдавливания или [Траектория]:). - Наберите P  Enter . 

Запрос: Select  extrusion path: (Выберите траекторию 
выдавливания:).- Укажите полилинию. 

Выполните визуализацию View -> Face Effects: (Рис.6)  
Осмотрите узел средством 3d orbit 
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Рис.5 

Построение тел вращения 

Для построения твердотельного объекта способом вращения 
необходимо выполнить следующие условия: 

- построить исходный профиль (плоская замкнутая фигура), в качестве 
которого могут использоваться только следующие примитивы: круг, 
эллипс, замкнутая двухмерная полилиния, все вершины которой лежат в 
одной плоскости, замкнутый сплайн, у которого также все вершины лежат 
в одной плоскости, и область; 

- исходный профиль не должен иметь петли и складки; 
- в качестве осевой линии, которая фигурирует в опции Object 

(Объект), могут использоваться только отрезок и полилиния, имеющая 
один прямолинейный сегмент, кроме этого ось не должна быть 
перпендикулярной к плоскости профиля и не должна пересекать профиль.   

На данном этапе мы будем использовать команду Pline и 
относительные полярные координаты для построения профиля детали.    

   О полярных координатах. Полярные координаты могут быть 
относительными и абсолютными. Чаще всего используют относительные 
полярные координаты. Полярные координаты задаются в формате 
«расстояние < угол». Пара относительных полярных координат должна 
начинаться 
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  Рис. 6 

 

с символа @. В AutoCAD 
углы измеряются и 
задаются в соответствии 
с диаграммой, 
изображенной на рис. 6, 
хотя при желании 
можно использовать 
свою систему. 

Откройте новый 
файл на базе 
Acadiso.dwt. В строке 
состояния включите 
кнопки Grid, Snap и 
Polar. На экране 
появится сетка, и будут 
отслеживаться полярные 
координаты. Из панели 
инструментов Home-
>Draw выберите 
Polyline. 

 

Запрос: Specify start point: (Точно укажите начальную точку :). -  
Введите 200, 160 и Enter. 

Запрос: Specify next  point or [Arc  / Halfwidth / Length / Undo / Width]: 
(Точно укажите следующую точку или [Дуга / Полуширина / Длина/ 
Отмени / Ширина]:). - Введите @ 80< 90  Enter (или отслеживая на экране 
отсчет полярных координат щелкните левой кнопкой мыши в нужной 
точке). 

Введите: @ 30< 0;  Enter.  

Введите: @ 40< 270;  Enter. 

Введите: @ 80< 0;  Enter. 

Введите: @ 40< 90;  Enter. 
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Введите: @ 10< 0;  Enter. 

Введите: @ 80 < 270;  Enter. 

Введите: @ 10 < 180;  Enter. 

Введите: @ 30 < 90;  Enter. 

Введите: @ 80 < 180;  Enter. 

Введите: @ 80 < 270;  Enter. 

Введите: С ;  Enter. 

Изображение на дисплее должно соответствовать рис. 7. 

Из панели инструментов Solids->Modeling выберите 
команду Revolve (Вращать). 

Запрос: Select objects. - Выберите полилинию. 

Запрос: Select objects. - Нажмите Enter. 

Запрос: Specify start point for axis of revolution or define axis by [Object / 
X axis / Y axis (Точно укажите начальную точку для оси вращения или 
определите для [Oбъект / ось X /ось Y]). – Наберите 340, 240;  Enter. 

Запрос: Specify end point of axis (Точно укажите конечную точку оси). - 
Наберите 340, 160; Enter. 

Запрос: Specify angle of revolition<360> (Точно укажите угол 
вращения <360>). - Наберите 270;  Enter. 

Чтобы посмотреть результаты, щелкните на пиктограмме SW Isometric 
View  на панели инструментов Viewpoint. 

Изображение на дисплее должно соответствовать рис. 8. 
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Рис. 7 

   

 

Рис. 8 

 

Вопросы для самоконтроля 
 

1. Какая панель инструментов необходима для создания 
твердотельных моделей? 

2. Какой системной переменной регулируется отображение 
криволинейных поверхностей и чему равно ее значение по 
умолчанию? 

3. Какие стандартные твердотельные модели можно сформировать в 
AutoCAD ? 

4. Для чего служит команда Extrude? 
5. Какие объекты можно использовать для создания выдавленных 

тел? 
6. Какая объектная привязка используется для выполнения разреза? 
7. Чем команда Slice отличается от команды Section? 
8. Какая команда выполняет выдавливание по траектории? 
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Практическое задание 
 

 1.Постойте  твердотельные модели  и выполните (где необходимо) 
разрез в соответствии с нижеследующими рисунками. 
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Практическая  работа № 3 

 
РАБОТА С ПОЛЬЗОВАТЕЛЬСКОЙ СИСТЕМОЙ КООРДИНАТ 

 

Цель занятия 
 

Создание пользовательской системы координат и приобретение 
практических навыков в работе с ней. Выполнение упражнений по 
использованию основных команд AutoCAD: UCSIcon,NewUCS. 

 

Порядок выполнения 
 

Практическая работа заключается в последовательной реализации 
нижеследующего интерактивного диалога с системой 
автоматизированного проектирования AutoCAD. 

Использование пиктограммы ПСК 

В AutoCADвсе геометрические объекты привязываются к глобальной 
прямоугольной абсолютной системе координат, которая называется 
мировой системой координа -МСК  (WorldCoordinateSystem). Когда в 
чертеже установлена МСК, пиктограмма ПСК маркируется символом W. 
При двухмерном черчении пиктограмма соответственно определяет х иу. 
Для  трехмерной модели, в большей части, работа начинается с 
двухмерной фигуры, т.е. в плоскости ху. Чтобы перейти из плоскости 
параллельной ху, нужно заменить ПСК таким образом, чтобы её плоскость 
была параллельна плоскости, порождающей трехмерный объект. Изменяя 
ориентацию и положение ПСК, можно задать любое положение и любую 
ориентацию плоскостиху, где и работают команды двухмерного черчения. 
Если плоскостьху,в процессе выбора новой ПСК проецировалась в линию, 
то вид пиктограммы меняется на сломанный карандаш. Основой 
трехмерных построений является применение ПСК и объектной привязки.  
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Для создания собственной ПСК выберите в меню View->Coordinates, 
в которой предлагается множество опций (рис. 1): 

World(МСК) –делает текущей мировую систему координат; 

Object(Обьект )- определяет новую ПСК соответственно 
двухмерному обьекту. Плоскость ХУ совмещается с плоскостью, 
определяемой обьектом. 

 

 

          Рис. 1 

 

Face(грань)- совмещает плоскость ПСК с гранью трехмерного 
твердотельного объекта. 

View(вид)- новая ПСК создается параллельно текущему виду, а ее 
начало совмещается с началом текущей ПСК. 

Origin(начало )- из текущей ПСК плоскопараллельным  переносом 
создается новая ПСК, указанная точка берется за начало. 

ZaxisVector(Z ось) –  переносит начало новой ПСК в указанную 
трехмерную точку и направляет ось z соответственно другой указанной 
точки.3 Point(3 точки)- задает положение новой ПСК в пространстве ( 
первая точка – начало, вторая – направление оси Х, третья- направление 
осиУ 

Х - новая ПСК создается поворотом текущей вокруг оси Х 

У - соответственно поворотом вокруг осиУ 

Z- поворотом вокруг оси Z. 
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Упражнение 

Сложность композиции, показанной на рис. 2, определяется рядом 
геометрических условий, предъявляемых к взаимному расположению  
многогранников и конуса. 

 

 

Рис. 2 

 Добиться взаимного расположения многогранника и конуса можно 
только оптимальным заданием ПСК и применением объектной привязки. 

В качестве камней возьмем параллелепипеды − это наиболее 
простой вариант композиции. 

Установите постоянно действующими объектные привязки 
Intersection(Пересечение) и Endpoint (Конечная). 

Основание. Стройте  камень (основание) композиции как 
параллелепипед, задавая его размеры в глазомерной пропорции,(Рис. 2) 

Home->Build->Box: 

length – длина 150; 

width – ширина 120; 

height – высота 10. 

Основание было построено в исходной (мировой) системе 
координат. Для создания второго камня  перенесем плоскость построений 

Рис. 2 
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на верхнюю грань основания, применив команду UCS (ПСК) с опцией  
Origin. Эти опции осуществляют параллельный перенос системы 
координат в новое начало, в качестве которого назначим левую ближнюю 
вершину верхней грани основания. Для указания вершины потребуется 
объектная привязка; в связи с этим вспомним, что привязка включена как 
постоянно действующая. Если привязка не включена, то перед указанием 
вершины ее следует включить как разовую. 

Для  того чтобы видеть аксонометрию, фронтальную и 
горизонтальную  проекции композиции, создадим видовые окна. 

ViewViewportsNamed(ВидВидовые экраныНазванные 
виды). В открывшемся диалоговом окне установим:NewViewports-
>StandardviewportThree:Right,Setup3D(Стандартные экраныТри: 
право, Установка - 3Д) (Рис.3). 

 

 

Рис.3 

Для вызова команды UCS  воспользуйтесь панелью инструментов, 
меню или введите с командной строки: 
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 View->ViewportsOrigin, перейдите в окно аксонометрии, подведите 
курсор к вершине и дождавшись подтверждения привязки, укажите 
вершину. Результат: пиктограмма осей разместилась  на верхней
 грани основания. Присвойте созданную систему координат
 другим окнам, для этого надо перейти в окно и выбрать 
сохранённую систему координат (камень). 

 

Первый камень. Постройте первый камень аналогично основанию 
Home->BuildBox: 

length – длина50; 

width – ширина40; 

height – высота 50. 

Откорректируйте его положение командами Move (Перенести) и 
Rotate (Повернуть). В окне аксонометрии удалите невидимые линии 
командой Hide (Скрыть) (рис.4). 

 

 

 

 

 

 

 

 

 

Рис. 4 
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Второй камень .Для построения второго камня, по пиктограмме 
осей убедитесь, что плоскость построений ПСК расположена на камне - 

основании. Для этого примените опцию: View->Coordinates3-
point, напомним, что должна быть включена объектная привязка 
Пересечение. Постройте второй камень, предварительно расположив его 
на основании так же, как и первый. Размеры камня задайте в глазомерной 
пропорции, например: 

length – длина50; 

width – ширина30; 

height – высота 70. 

  

Переместите второй камень командой Move по основанию, установив 
его на нужном расстоянии от первого камня. 

Дальше установите ПСК так, чтобы ось Z была направлена вдоль ребра 
1−2, на которое должен опереться второй камень, причем плоскость XOY 
должна быть перпендикулярно основанию. 

 

 

 

 

 

 

 

 

Рис.5 
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Для этого примените опцию ZAxis (Z ось) команды UCS. (или 
воспользуйтесь панелью инструментов) последовательно укажите точки 1 
и 2 как определяющие направление оси Z. 

 Результат: пиктограмма приняла положение, указывающее, что 
плоскость XOY перпендикулярна ребру 1−2. Направление осей X иY может 
быть произвольным. 

После задания ПСК повернем второй камень вокруг оси, 
проходящей через точку 8, параллельно оси Z. Применим опцию 
Reference(Ссылка), которая позволяет задать угол поворота как угол 
между проекциями прямых на плоскость вращения. В данном случае 
поворот нужно осуществить так, чтобы проекция на плоскость XOY ребра 
4-8, играющего роль ссылки, совпала с проекцией прямой 8-1. 

 Применим команду вращения Rotate3D (укажите поворачиваемый 
камень) ZAxis(в качестве базовой точки укажите точку 8)Reference (на 
запрос "Угол ссылки" последовательно укажите точки 4 и 1). 

Результат: второй камень установлен в требуемое положение(рис.6). 

Конус. Напомним, что конус  должен лежать на основание  второго камня. 
Поэтому приступать к построению конуса нужно после правильности 
установки второго камня. 

 

Рис.6 
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Установите ПСК на плоскость основания второго камня. Задайте 
ПСК по трем точкам: начало, точку 9, укажите на основании, где сейчас 
задана ПСК; ось X направьте в точку 10; в качестве третьей точки укажите 
точку 1. 

Результат: ПСК установлена, как показано на рис.7, причем точка 9 
принадлежит верхней грани основания. 

 

Рис. 7 

Построим конус на основание плоскости второго камня. С помощью 
привязки установим конус в центр координаты и зададим нужные нам 
параметры: 

radius(радиус) -30; 

height (высота) - 70. 

Дальше применим команду move и переместим в центр второго камня. 
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Рис.8 

 

 

Сохранение вида и ПСК 

Вид − это сочетание условий проецирования объектов на экран. В 
процессе построений виды на экране приходится постоянно изменять, 
поэтому отдельные из них, ключевые, нужно сохранять. Сохранение 
осуществляется путем присвоения виду имени, по которому его можно 
восстановить без повторения построений. Например, целесообразно 
сохранить найденный выше вид, доказывающий правильность 
выполненного построения второго камня. Это позволит при оформлении 
работы быстро установить сохраненный вид в одном из видовых окон. 

Активизируйте окно с сохраняемым видом: ViewViewportsNew, 
введите имя вида, например Камень2OK. 

Результат: вид сохранен под указанным именем. 

Проверьте сохранение вида. Вызовите его по имени из другого окна, 
например из окна вида сверху. 

Активизируйте левое нижнее окно: ViewNamed (укажите строку 
с именем ранее сохраненного, а сейчас восстанавливаемого вида)OK. 

Результат: вид сверху заменен восстановленным видом. 
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Отменим установленный вид и вернемся к предыдущему 
виду данного окна:ViewNavigatePrevious. 

Так же, как и вид, с той же целью быстрого последующего 
восстановления сохраняют ПСК. Например, сохраним текущую ПСК, 
которая позволила завершить построение второго камня: 
ViewCoordinatesNamedUnnamed, поверх указанной строки 
ввести имя ПСК. 

Ранее сохраненную ПСК можно вызвать по 
имени:ViewCoordinatesNamedSetCurrent. 

Упражнение 
По умолчанию в AvtoCad   есть несколько систем координат  они 
находится  View-Coordinates. (рисунок 9) 

 

Рис. 9 

Система которая горит в форточке является текущей на рис.1 
изображена  (world )  

Если нам надо создать свою систему координат  с разными 
параметрами (поворота вокруг оси) для этого есть специальные  функции, 
чтобы понять как их использовать, как создавать проделаем упражнение. 

Основание 

Для этого сначала выберем  изометрию перейдём  view-views-SE 
Isometric   далее в произвольном   месте нарисуем  box. 

             Home->Build->Box: 
length – длина 1000; 
width – ширина 1000; 

           height – высота 1000. 
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Изображение должно соответствовать рисунку 10. 

 

                      Рис.10 

Первый камень был построен в исходной (мировой) системе 
координат. Для создания других камней  перенесем плоскость построений 
на другие высоты применив команду UCS (ПСК) с опцией Origin. 
Привязки при этом надо отключить. 

Для  того чтобы видеть аксонометрию, фронтальную и 
горизонтальную  проекции композиции, создадим видовые окна. 

ViewViewportsNamed(ВидВидовые экраныНазванные 
виды). В открывшемся диалоговом окне установим:NewViewports-
>StandardviewportThree:Right,Setup3D(Стандартные экраныТри: 
право, Установка - 3Д) (Рисунок.11). 

 

Рис.11 
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Новые системы координат 

Создадим системы  координат на высоте 1000,2000,3000,4000 и 
сохраним их (рисунок 12). 

View->ViewportsOrigin 

И вводим координаты  

X-0; 
y-0; 
z-1000; 
Теперь это систему координат надо сохранить . 
 

 

                         Рис. 12 

 

ViewCoordinatesNamed  она отобразилась и называется Unnamed   
далее мы переименуем её в  “z 1m”. 

Создаём следущую координату, при этом надо вернуться в мировую 
систему координат. 

View->ViewportsOrigin 

И вводим координаты  

X-0; 
y-0; 
z-2000; 
 

Теперь это систему координат надо сохранить. 
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ViewCoordinatesNamed она отобразилась и называется Unnamed   
далее мы переименуем её в  “z 2m”. 

Таким же образом создаём систему координат для 3000 и 4000 и не 
забываем возвращаться в мировую систему координат. 

И сохраняем под именем  “z 3m” и “z 4m”. 

Строим камни. 

Переходим в окно TOP и выбираем систему координат  “z 1m”. 

Строим второй камень, начало координаты камня  выбираем произвольно, 
но чтобы лежала  на грани основания. Изображение  на экране должно 
соответствовать изображению на рисунке 13. 

Home->Build->Box: 
length – длина 1000; 
width – ширина 1000; 

          height – высота 1000. 
 

 

Рис. 13 

 

Строим третий камень, для этого выбираем систему координаты   
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“z 2m” и также пройзвольно выбираем начало координаты, но чтобы 
лежало на основание второго камня.(рисунок 14) 

Home->Build->Box: 
length – длина 1000; 
width – ширина 1000; 

          height – высота 1000. 
 

 

Рис. 14 

 

Таким же способом строим 4-ый и 5-ый камень выбирая нам нужные 
системы координат (рисунок 15). 

 

Рис. 15 
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Далее создадим систему координат по 3-ём точкам. Для этого 

примените опцию: View->Coordinates3-point, напомним, что 
должна быть включена объектная привязка Пересечение),последовательно 
укажите точки 1,2,3. И построим камень на основание 5-ого камня. 
Откорректируйте его положение командой (Повернуть). В окне 
аксонометрии удалите невидимые линии командой Hide (Скрыть). 

 

 

Рис. 16 

Далее закрасим камни Home->view->realistic кликнем 2 раза по 
каждому камню левой кнопкой мыши, выберем  функцию color и 
выбираем нам нужный цвет. 

 

 

Рис.17 
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Создадим последнюю систему координату и повернём её вокруг оси z 

на 45 градусов. Для этого примените опцию: View-

>Coordinates3-point.Потом выберем    и на берём угол “-45”. Далее 
на рисуем камень и выберем цвет. 

Home->Build->Box: 
length – длина 1000; 
width – ширина 1000; 

           height – высота 1000. 
 

Вопросы для самоконтроля 
 

1.Что такое пользовательская система координат? 

2.Как сформировать пользовательскую систему координат? 

3.Как восстановить ранее сохраненную систему координат? 

4.Для чего служит команда MoveUCS? 

5.Как использовать команду NewUCSпри построении трехмерных фигур? 

6.Какие опции настройки ПСК Вы знаете? 

7. Что такое вид? 

8. Как создать видовые экраны? 
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Практическое задание 
 

Выполните пирамиду изображенную на рисунке. 
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Практическая работа № 4 

 
РЕДАКТИРОВАНИЕ ТЕЛ 

 

Цель занятия 

Приобретение практических навыков в создании и редактировании 
объемных тел.  

Порядок выполнения 

 

Практическая работа заключается в последовательной реализации 
нижеследующего интерактивного диалога с системой 
автоматизированного проектирования AutoCAD  и выполнении 
индивидуального задания. 

 

Редактирование тел 

В версии 14 AutoCAD возможности модифицирования тел были 
довольно ограничены:  снятие фасок, сглаживание ребер, разрезание тел, 
расчленение на примитивы других типов и три основные логические 
операции (аналоги операций над множествами). 

Начиная с AutoCAD 2000, появилась новая команда SOLIDEDIT 
(Редактирование тела), которая позволяет значительно расширить 
возможности системы в этой части. Команда имеет множество опций, так 
что фактически представляет собой объединение нескольких команд.  

Команда SOLIDEDIT предлагает пользователям три главные группы 
операций с телами. 

Faces (Грани). Набор опций этой группы позволяет редактировать 
поверхности, ограничивающие сплошное тело,— вытягивать их, 
переносить, поворачивать, смещать, заострять, удалять, копировать и 
присваивать индивидуальный цвет. 
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Edges (Ребра). Ребра можно копировать и присваивать индивидуальный 
цвет. 

Bodies (Тела). Опции этой группы модифицируют сплошное тело целиком. 
Можно делать оттиск двух- или трехмерного объекта на поверхности тела, 
расчленять тело на компоненты, которые также являются телами, очищать 
объект и проверять корректность структуры. Выполнить эти опции 
значительно проще, чем их описать. 

Самый простой способ - открыть панель инструментов Solids->Solid 
Editing (Рис. 1). 

 

 

Рис. 1 

 

В работе рассматривается наиболее интересная возможность 
команды SOLIDEDIT, которая заключается в преобразовании поверхности 
solid-объекта в тонкостенную оболочку. Это позволяет моделировать 
широкий круг объектов, например детали, получаемые тонколистовой 
штамповкой, или архитектурные своды.  

При построении оболочек рекомендуем увеличить плотность 
каркаса до FACETRES = 5... 10, это повысит наглядность и устранит 
дефекты визуализации. FACETRES – это системная переменная, которая 
регулирует плавность закрашивания и тонирования трехмерных объектов 
и объектов с сокрытием невидимых линий.  

 

Упражнение. Формирование оболочки тела 
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Представьте себе, что нужно сформировать сосуд, взяв за основу тело. 
Именно это и выполняется опцией Shell (Оболочка) команды 
SOLIDEDIT. Такая операция является стандартной процедурой в 
современных системах пространственного моделирования. Выполняется она 
следующим образом. 

Создайте тело вращения, состоящее из двух частей: ножки и чаши. Для 
построения ножки:  

Щелкните на пиктограмме Polyline (Полилиния) панели инструментов 
Home->Draw. 

Запрос: Specify start point: (Точно укажите начальную точку :). -  
Введите: 150, 20 и Enter. 

Запрос: Specify next  point or [Arc  / Halfwidth / Length / Undo / Width]: 
(Точно укажите следующую точку или [Дуга / Полуширина / Длина/ 
Отмени / Ширина]:). - Введите: @ 80< 0;  Enter (или, отслеживая на экране 
отсчет полярных координат щелкните левой кнопкой мыши в нужной 
точке). 

Введите: 160, 30;  Enter.  
Введите: 160, 140;  Enter. 
Введите: 150, 140; Enter. 
Введите: С;  Enter. 
Для построения чаши:  
Щелкните на пиктограмме Polyline (Полилиния) панели инструментов 

Home->Draw. 
Запрос: Specify start point: (Точно укажите начальную точку :). -  

Введите: 160, 140 и Enter. 

Запрос: Specify next  point or [Arc  / Halfwidth / Length / Undo / Width]: 
(Точно укажите следующую точку или [Дуга / Полуширина / Длина/ 
Отмени / Ширина]:). - Введите: A (Дуга);  Enter. 

Запрос: Specify endpoint of arc or [Angle / Center / Direction  / Halfwidth 
/ Line  / Radius / Second pt /  Undo / Width]: (Точно укажите конечную точку 
или [Угол / Центр / Направление / Полуширина / Отрезок / Радиус / Вторая 
точка / Отмени / Ширина]:). - Введите: S (Вторая точка)  Enter. 
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Запрос: Specify second point of arc: (Точно укажите вторую точку дуги:).  
Введите 210,140. 

Запрос: Specify endpoint of arc: (Точно укажите конечную точку дуги:).                                                                               
Введите 290, 220. 

Запрос: Specify endpoint of arc or [Angle / Center / Direction  / Halfwidth / 
Line  / Radius / Second pt /  Undo / Width]: (Точно укажите конечную точку 
или [Угол / Центр / Направление / Полуширина / Отрезок / Радиус / Вторая 
точка / Отмени / Ширина]:). - Введите: L (Отрезок)  Enter. 

 

Рис.2 

Запрос: Specify next  point or [Arc  / Halfwidth / Length / Undo / Width]: 
(Точно укажите следующую точку или [Дуга / Полуширина / Длина/ 
Отмени / Ширина]:).  Введите: 150, 220;  Enter. 

Введите: 150, 140;  Enter.  

Введите: С;  Enter. 

Изображение на дисплее должно соответствовать рис. 2.  

Из панели инструментов Solids->Modeling выберите команду Revolve 
(Вращать). 

Запрос: Select objects. - Выберите обе полилинии. 
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Запрос: Select objects. - Нажмите Enter. 

 

Запрос: Specify start point for axis of revolution or define axis by [Object / 
X Аxis / Y Аxis (Точно укажите начальную точку для оси вращения или 
определите для [Oбъект / ось X /ось Y]). – Наберите 150, 220. Нажмите 
Enter. 

Запрос: Specify end point of axis (Точно укажите конечную точку оси). - 
Наберите 150, 20. Нажмите Enter. 

Запрос: Specify angle of revolition<360> (Точно укажите угол 
вращения <360>). - Нажмите Enter. 

Чтобы посмотреть результаты, щелкните на пиктограмме SW Isometric 
View  на панели инструментов View->Appearence и наберите в командной 
строке Hide (Скрыть) для скрытия невидимых линий. 

Изображение на дисплее должно соответствовать рис. 3.  

 

 

Рис.3 

Щелкните на пиктограмме Shell (Оболочка) панели инструментов Solids 
Editing (Редактирование тел). 

Запрос: Select a 3D solid: (Выберите тело:). - Выберите чашу. 

 

Рис. 2 
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Запрос: Remove faces or [Undo/Add/ALL]: (Удалять грань или 
[Отменить/Добавить/Все]:). - Выберите верхнюю грань чаши, т.к. ее не надо 
включать в оболочку.  

Завершив отбор удаляемых граней, нажмите Enter. (В командной строке 
появится подтверждающее сообщение 1 face found, 1 removed (1 грань 
найдена, 1 грань удалена), но это отнюдь не значит, что AutoCAD удалил 
именно ту грань, которую задумал пользователь, особенно  в случае не очень 
удачного выбора точки зрения. 

Запрос: Enter the shell offset distance: (Введите толщину стенки 
оболочки:). – Введите 4 и нажмите Enter. 

Положительное значение этого параметра приведет к созданию 
оболочки "в тело", отрицательное — оболочки снаружи. 

Для завершения выполнения команды дважды подряд выберите пункт 
Exit в контекстном меню. AutoCAD сформирует оболочку.  

Изображение на дисплее должно соответствовать рис. 4.  

 

 

Рис.4 
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Проверка корректности описания объекта-тела 

 

Одна из парадигм программирования гласит: никакая проверка не 
бывает лишней. Проверка корректности описания объекта-тела с достаточно 
большой вероятностью избавит вас от сообщения об ошибке выполнения 
операции графическим процессором ACIS.  

Щелкните на пиктограмме Check (Проверка) панели инструментов 
Solids Editing. В ответ на запрос Select a 3D solid: (Выберите трехмерное 
тело:) выберите тело, структура описания которого будет 
анализироваться. Если со структурой все нормально, AutoCAD выведет 
сообщение This object is a valid ACIS solid (Это корректное тело ACIS). 
Проверьте на корректность описания объект-чашу. 

 

Вопросы для самоконтроля 
 

1. Какая панель инструментов необходима для редактирования 
твердотельных моделей? 

2. Какой системной переменной регулируется плавность 
закрашивания и тонирования трехмерных объектов и объектов с 
сокрытием невидимых линий?  

3. С помощью какой команды можно построить тело вращения? 
4. Каковы этапы выполнения команды Revolve? 
5. Какая команда строит оболочку? 
6. Как проверить корректность описания объекта-тела? 
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Практическое задание 
 

Выполните нижеследующие рисунки с использованием команды Shell. 
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Практическая работа № 5 

 
BИЗУАЛИЗАЦИЯ ИЗОБРАЖЕНИЙ ТРЕХМЕРНЫХ 

ОБЪЕКТОВ В  AutoCAD 

 
Цель работы 

Приобретение практических навыков в моделировании освещения и 
тонировании изображений трехмерных объектов, импортировании и 
экспортировании файлов. 
 

Порядок выполнения 
 

Практическая работа заключается в последовательной реализации 
нижеследующего интерактивного диалога с системой 
автоматизированного проектирования AutoCADи выполнении 
индивидуального задания. 

Раскрашивание трехмерных моделей 
 

Раскрашивание (Shading) - упрощенная версия тонирования - 
используется, когда необходимо получить наглядное представление 
модели. 

Ниже приведены опции команды Shademode(Раскрасить). 

2D Wireframe(2М каркас). Отображение объектов в виде привычной 
каркасной модели без всякого раскрашивания. Эта опция используется для 
возвращения к обычному режиму отображения. 

3D Wireframe(3М каркас). Отображение объектов в виде привычной 
каркасной модели, но вместе с трехмерной пиктограммой ПСК 
(Пользовательской Системой Координат). 
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Hidden(Скрыть). Эквивалентна выполнению команды Hide(Скрой). 

FlatShaded(Безтени).Формирование «плоской» без полутонов заливки 
областей, ограниченных контурами граней. При этом не учитывается 
ориентация граней, а также и изменение вследствие этого их 
освещенности. 

GouraudShaded(Гуро). Формирование сглаженного полутонового 
перехода между по-разному ориентированными гранями. В 
результатесоздается довольно реалистичное представление объекта, 
подчеркивающее его криволинейную пространственную форму.  

Flat Shaded, Edges On (Безтенискромками).Комбинация плоской 
заливки с каркасным представлением ребер (рекомендуется устанавливать 
при выполнении редактирования объектов). 

Gouraund Shaded, Edges on (Гуроскромками). Раскрашивание по 
методу Гуро с выводом каркасного представления ребер. 

Упражнение. Раскрашивание модели 

Загрузите файл с моделью тела вращения или создайте модель заново. 
Выберите для модели цвет 253. Изображение на дисплее должно 
соответствовать рис. 1. 

 

Рис. 1   
Рис. 2 

Рис. 3 

 

Для выполнения раскрашивания выберите в меню ViewFace 
EffectsShade Flat Shaded(ВидРаскрашиваниеБезтени). 
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Изображение на дисплее должно соответствовать рис. 2. 

Затем выберите в меню ViewShadeGouraundShaded, 
EdgesOn(Гуроскромками) (рис. 3). Повторите раскрашивание в других 
вариантах. Сохраните рисунок.  

Использование FreeOrbit 

Функция FreeOrbitвпервые появилась в версии AutoCAD 2000. Она 
представляет собой совершенно новый для AutoCADинструмент просмотра 
пространственных моделей. С помощью этой функции можно легко 
перемещать модель по экрану, изменять масштаб представления, 
формировать параллельную или перспективную проекцию модели и даже 
включить непрерывное вращение модели на экране. Режим 
FreeOrbitустанавливается щелчком на пиктограмме 3D Оrbit, которая 

находитсяв меню View->Navigate. После этого вокруг 
изображения выделенных объектов появляется 
координатный шар, показанный на рис. 4. В режиме 
FreeOrbitAutoCADпо-разному реагирует на манипуляцию 
курсором в разных областях поля чертежа. шара и 
заключенных в него объектов вокруг воображаемой оси, 

которая выходит из  центра координатного шара перпендикулярно 
плоскости экрана. 

 

 

Рис. 4 
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Вращение в режиме Sphereandlines. Если передвинуть курсор во 
внутреннюю по отношению к контуру координатного шара область, то он 
примет форму «a smallsphereencircledbytwolines» (маленькая сфера с двумя 
линиями). В этом режиме объекты вращаются вокруг воображаемой оси, 
которая проходит через центр координатного шара, лежит в плоскости, 
параллельной плоскости экрана, и направлена перпендикулярно 
направлению перемещения курсора. 

Вращение изображения модели вокруг вертикальной оси. Если 
передвинуть курсор в правую или левую круговую область на контуре 
координатного шара, то он примет форму эллипса, вытянутого по 
горизонтали. В этом режиме процедура буксировки курсора приводит к 
вращению объектов вокруг вертикальной оси, которая проходит через 
центр шара и лежит в плоскости, параллельной плоскости экрана. 

Вращение изображения модели вокруг горизонтальной оси. Если 
передвинуть курсор в верхнюю или нижнюю круговую область на контуре 
координатного шара, то он примет форму эллипса, вытянутого по 
вертикали. В этом режиме процедура буксировки курсора приводит к 
вращению объектов вокруг горизонтальной оси, которая проходит через 
центр координатного шара и лежит в плоскости, параллельной плоскости 
экрана.  

Можно организовать непрерывное вращение. Для этого нужно 
выбрать из меню ContinuousOrbit.Щелкните кнопкой мыши и укажите 
желаемое направление вращения точно так же, как это делается в режиме 
sphereandlines. 

Отпустите кнопку мыши. Изображение будет продолжать вращаться в 
том же направлении. Все, что от вас требуется - сидеть и наблюдать. 

 

Упражнение. Вращение изображения модели 

Загрузите файл, который вы сохранили в предыдущем упражнении. 

 Повращайте деталь в режиме CircularArrow. Изображение на дисплее 
должно соответствовать рис. 5. 
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Рис. 5 

 
Тонирование изображения 

Тонирование (Rendering) - значительно более сложное 
средство визуализациии чертежа по сравнению с 
раскрашиванием. В AutoCADпредставлены три вида 
тонирования: упрощенное (Render), фотореалистичное 
(PhotoReal) и трассировка луча (PhotoRaytrace). 

Render- вариант выполнения тонирования, который представляет 
наименьшие возможности настройки и моделирования различных 
эффектов визуализации, но дает наиболее быстрые результаты. 

PhotoReal- вариант, при котором изображение на экране формируется 
строка за строкой. Этот вариант позволяет включать фрагменты 
изображения в растровом формате, создавать прозрачные материалы, а 
также моделировать различные эффекты при отображении теней. 
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PhotoRaytrace- вариант выполнения тонирования, в котором 
реализуется алгоритм обратной трассировки световых лучей для генерации 
отображения, преломления и точного определения освещенности. 

Упражнение. Выполнение тонирования по умолчанию 

Откройте новый рисунок на базе шаблона acadiso.dwt. 

Для выполнения тонирования откройте панель инструментов 
Render(Тонирование) (рис. 6). 

 

Рис. 6 

 

 

Рис. 7 

Создайте твердотельную 
модель шара с центром в точке с 
координатами (200, 200), радиусом, 
равным 100. 

Щелкните на пиктограмме 
стрелочки в нижнем правом углу 
панели Renderпанели инструментов 
Render.  Появится диалоговое окно 
Render (рис. 7) 
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В разделе Rendering Context установите Procedure на Crop. Щелкните 
на кнопке Render. 
Запрос: Pick crop window to render. (Выделите окно для тонирования). 
Выделите прямоугольной рамкой фрагмент, включающий модель шара. 
Подождите, пока AutoCAD выполнит тонирование модели. Изображение на 
дисплее должно соответствовать рис. 8. 

 

Рис. 8 

 

Работа с материалами 

Работа с материалами включает в себя два этапа: добавление 
материалов к чертежу и привязка материалов к объектам. 

В AutoCADесть большой выбор материалов. Их можно изменять или 
создавать собственные. 

 

Упражнение. Импорт материалов и 
привязка к объекту 

Materials (рис.9). Щелкните на кнопке 
Create New Material (Новый) 

Откройте чертеж с изображением шара. 
Щелкните на пиктограмме Materials панели 
инструментов Render. Появилось диалоговое 
окно. 

В текстовом поле Name (Имя 
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материала)введите имя материала. 

Нажмите ОК. 

В выпадающем списке Maps-Global отметьте Diffusemap, поставьте 
Maptype в TextureMapи нажмите SelectImage. Выберите из списка любую 
текстуру. Результаты будут видны на сфере выше. 

 

 

 

Рис. 9 
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Щелкните на кнопке ApplyMaterialtoObjects, чтобы привязать 

материал к объекту. AutoCADвременно возвратится к чертежу.  

Запрос:Selectobjects:.Щелкните левой кнопкой мыши на модели шара и 
нажмите Enter. 

Щелкните на кнопке Render панели инструментов Render. 

Выделите прямоугольной рамкой модель шара. Пример созданного 
изображения представлен на рис. 10. 

 

Рис. 10 

Щелкните на пиктограмме Materials  панели инструментов Render(вы 
рaботаете с тем же изображением шара). Появилось диалоговое окно 
Materials (см. рис. 10). 

Упражнение. Добавление фона 

Если чертеж с изображением шара открыт, то используйте его, если 
нет, то откройте файл, созданный в предыдущем упражнении. 

Введите в командной строке View. 

Выберите ModelViewsи щелкните New. В появившемся диалоговом 
окне введите имя в поле Viewname.В группе параметров 
Backgroundвыберите из списка Imageи в появившемся диалоговом окне 
укажите путь к изображению. Жмите ОК до упора. 

Создание источников освещения 
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Для создания источников освещения необходимо щелкнуть на 
пиктограмме CreateLight панели инструментов Render->Lights, показанной 
на рис. 11. 

    
Рис. 11 

 

В AutoCAD предполагается три источника света, что дает 
возможность создания реалистических сцен. 

Pointlight(Tочечный) является эквивалентом обычной электрической 
лампочки. Свет исходит из определенной точки в пространстве модели и 
распространяется по всем направлениям. Точечный свет рассеивается, т.е. 
интенсивность света уменьшается по мере удаления от источника. 

Spotlight(Прожектор) отличается от точечного источника света тем, 
что создает направленный поток. Поэтому для прожектора указывается не 
только его расположение, но и положение целевой точки. 

DistantLight(Удаленный) соответствует солнечному освещению, 
источник расположен очень далеко, поэтому световой поток полагается 
параллельным. Кроме того, не учитывается спад интенсивности. 

Упражнение. Создание источников света 

Откройте файл, который вы сохранили в предыдущем упражнении. 
Щелкните на пиктограмме Lights (Источники света) панели инструментов 
Render. Выберите элемент DistantLight(Удаленный) в раскрывающемся 
списке. 
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Запрос: Specifylightdirection FROM <0,0,0>or [Vector]:<current>(Введите 
направление от<текущее>:). -Щелкните мышкой в точке с координатами 
(180, 480, 0). 

Запрос: Specifylightdirection TO <1,1,1>: (Введите направление 
к<текущему>:).- Укажите центр вашего шара. 
Запрос: Enter an option to change: 
[Name/Intensity/factor/Status/Photometry/shadoW/filterColor/eXit] <eXit>: 
Нажмите Enter. 
Для редактирования созданного источника света нажмите на изображение 
стрелочки в правом нижнем углу панели Render->Lights. 
В появившемся окне дважды нажмите на новый источник света. 
Пример показан на рис. 12. 
Введите D1 в текстовое поле Name (Имя источника света). 
Установите флажок ShadowOn. 
Установите цвет источника следующим образом. 

Чтобы установить цвет источника освещения выберите нужный цвет в 
спадающем меню Filtercolor.Выберите цвет источника света, например 
белый, и щелкните ОК. 

Установите интенсивность (яркость) света в поле 
IntensityFactor(Интенсивность) равной 1 (чтобы выключить удаленный 
источник света, интенсивность устанавливается нулевая). 

Щелкните на кнопке Render, чтобы увидеть результат. 
В диалоговом окне Render снимите флажок CropWindow. 
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Рис. 12 

В результате получите изображение, показанное на рис. 13, б. 
Сравните его с результатом выполнения предыдущего упражнения (рис. 
13, а). 

Поэкспериментируйте с установкой источника света в различных 
точках графической зоны, координаты второй точки задайте: 

1) 490, 180, 0  (рис. 13, в); 

 

2) 120, -60, 0 (рис. 13, г). 

 

 

Сохраните рисунок. 
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a) 

 

б) 

в) 

 

г) 

рис. 13 

 

 

Упражнение «Беседка» 

1.Создадим землю. 

Для этого необходимо в командной строке набрать: 

cylinder  (полнотелый цилиндр) 

200,200,-10;Enter (центр нижнего основания цилиндра) 

200;Enter  (радиус нижнего основания) 

10;Enter (высота цилиндра) 

2.Создадим плиты основания здания: 
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2.1. Первая нижняя плита: 

box (полнотелый ящик) 

100,100,0;Enter (координаты левого нижнего угла) 

L;  Enter  (задаем, что это не куб, а параллелепипед) 

40; Enter  (длина параллелепипеда) 

60; Enter (ширина параллелепипеда) 

1;   Enter  (высота параллелепипеда) 

 

2.2. Вторая плита: 

box (полнотелый ящик) 

101,101,1;Enter (координаты левого нижнего угла) 

L;   Enter (задаем, что это не куб, а параллелепипед) 

38; Enter(длина параллелепипеда) 

58;   Enter (ширина параллелепипеда) 

1;  Enter (высота параллелепипеда) 

 

2.3. Третья верхняя плита: 

box Enter(полнотелый ящик) 

102,102,2;Enter (координаты левого нижнего угла) 

L;  Enter (задаем, что это не куб, а параллелепипед) 

36; Enter (длина параллелепипеда) 

56; Enter (ширина параллелепипеда) 

1; Enter (высота параллелепипеда) 

3. Рисуем колонну: 
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3.1. Рисуем основание колонны: 

box Enter (полнотелый ящик) 

105,105,3;Enter (координаты левого нижнего угла) 

L; Enter  (задаем, что это не куб, а параллелепипед) 

4; Enter  (длина параллелепипеда) 

4;Enter  (ширина параллелепипеда) 

1; Enter  (высота параллелепипеда) 

3.2. Рисуем ствол колонны: 

cylinderEnter  (полнотелый цилиндр) 

107,107,4; Enter (центр нижнего основания цилиндра) 

1; Enter  (радиус нижнего основания) 

16; Enter  (высота цилиндра) 

4. Копированиеповторяющиеся объектов: 

4.1. Выделим фигуры, получившиеся вследствие выполнения последних 

 2-х действий (3.1 и. 3.2): 

copyEnter  (команда копирования) 

107,107;Enter (координаты точки относительно, которой будет 
произведено копирование) 

120,107;Enter (координаты точки, куда будут скопированы объекты) 

4.2. Выделим ещё раз фигуры, созданные в. 3.1 и 3.2 (НЕ ТЕ, КОТОРЫЕ 
МЫ ПОЛУЧИЛИ В РЕЗУЛЬТАТЕ КОПИРОВАНИЯ): 

copyEnter  (команда копирования) 

107,107;Enter (координаты точки, относительно которой будет 
произведено копирование) 

133,107;Enter (координаты точки, куда будут скопированы объекты) 
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4.3. Выделим все фигуры получившиеся в 3.1, 3.2, 4.1, 4.2 (3 квадрата  

круга) 

copy Enter (команда копирования) 

107,107;Enter (координаты точки, относительно которой будет 
произведено копирование) 

107,153;Enter (координаты точки, куда будут скопированы объекты) 

4.4. Выделим 6 получившихся квадратов (ОКРУЖНОСТИ, они же 
колонны,  ВНУТРИ КВАДРАТОВ ВЫДЕЛЯТЬ НЕНАДО): 
copyEnter  (команда копирования) 

107,107,3;Enter (координаты точки относительно, которой будет 
произведено копирование) 

107,107,19;Enter (координаты точки, куда будут скопированы объекты) 

5. Создание крыши: 

5.1. Рисуем первый «клин»: 

wedgeEnter (полнотелый клин) 

120,100,20;Enter (координаты левого нижнего угла клина) 

L ;Enter (клин от скошенного параллелепипеда) 

20; Enter(длина) 

60; Enter (ширина) 

10; Enter (высота) 

5.2. Второй клин зеркально клонируем из первого: 

mirror3dEnter(команда копирования относительно 3-х измерений) 

Выделим фигуру, получившуюся в результате выполнения п. 5.1. (на виде 
сверху видна будет только линия). 

Нажмём ПРАВУЮ кнопку мыши. 

В командной строке введём: 



 

146 

 

YZ   (отражаем зеркально относительно плоскости YZ) 

120,100;Enter (относительно базисной точки с координатами 120, 100) 

N; Enter  (НЕ удаляем объект, который клонируем) 

6. Создадим декорации 

Выберите: Вид (View) → Рендеринг ( Rendering) → Создать ландшафт 
(Createlandscape). 

Найдите Cactus. 

Установите переключатель на CrossingFaces. 

Установите  Heightползунком на значение 10. 

Нажмите кнопку Position 

Введите в командной строке: 

150, 130;  Enter (координаты размещения кактуса) 

Нажмите кнопку  оk. 

7.Создание светильника. 

7.1. Первый светильник: 

cylinderEnter (создаем фонарный столб) 

90,90,0; Enter (координаты центра нижнего основания) 

D;Enter      (диаметр) 

1;Enter  (диаметр = 1) 

10;Enter                (высота столба) 

 

7.2. Создадим плафон светильника: 

ai_sphereEnter       (плафон шарообразной формы) 

90,90,11;  Enter        (координаты центра шара) 
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1; Enter                   (радиус шара) 

32;  Enter                  (число аппроксимирующих прямых ОХ шара) 

32; Enter          (число аппроксимирующих прямых ОY шара) 

7.3. Сделаем плафон стеклянным (чтобы свет проникал через него): 

Вид (View) →Рендеринг( Rendering) →Материалы (Materials); 

Нажмите кнопку «библиотека материалов» 

Выберите в списке материал «GLASS». 

Нажмите кнопку Import(импорт). 

Нажмите кнопку оk. 

Нажмите кнопку Attach (присоединить). 

Левой кнопкой мыши нажмите на фигуре которую создали в п. 7.2 (шар). 

Нажмите правую кнопку мыши. 

Нажмите кнопку оk. 

Построенная беседка показана на  рис. 14. Материал беседки выберите 
самостоятельно. 
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Рис. 14 

7.4. Размножим светильник: 

Обведите прямоугольником (курсором мыши) фигуры, созданные в п.п. 7.1 
и 7.2;  фигуру созданную в п. 7.1 (опору светильника), мы не увидим, т.к. 
её полностью закрывает плафон светильника.  
(Когда мы обводим прямоугольником данную область на экране, мы 
выделяем и плафон и опору светильника). 

copyEnter  (копируем) 

90,90;Enter  (откуда) 

150, 90;Enter (куда) 

Обведите прямоугольником (курсором мыши) уже 2-а получившихся шара 
(на виде сверху). 

copyEnter  (копируем) 

90,90; Enter (откуда) 

90, 170;Enter (куда) 

 

8. Создание источников освещения. 

Вид (View) →Рендеринг( Rendering) → Light→New 

lightEnter  (создаем источник света)  

Выберите в выпадающем меню «PointLight», нажмите 
кнопку  New(создать). 

Задайте имя источника света S1. 

Задайте интенсивность 200. 

Нажмите кнопку Modify (изменить). 

90,90,11;Enter  (координаты источника света) 

Задайте значения: 

1 
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красный  1 

зелёный  0.26 

синий  0.44 

Установите галочку в ячейке ShadowOn. 

Нажмите кнопку ok. 

 

Повторите, только измените имя на S2. 

 После нажатия кнопки «изменить» и  введите: 

 150,90,11;Enter   (координаты источника света). 

Значения цвета установите: 

красный  0.98 

зелёный  0.86 

синий  0.36 

Установите галочку в ячейке ShadowOn. 

Нажмите кнопку ok. 

 

Повторите п. 1, измените имя на S3 

 После нажатия кнопки Modify (изменить) введите 

 150,170,11;Enter   (координаты источника света) 

 

Значения цвета установите: 

красный  0.32 

зелёный  0.4 

синий  0.9 
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Установите галочку в ячейке ShadowOn. 

Нажмите кнопку ok. 

 

Повторите п.1, измените имя на S4 

 После нажатия кнопки Modify (изменить)введите 

 90,170,11  Enter  (координаты источника света)  

 

Значения цвета установите: 

красный  0.11 

зелёный  0.53 

синий  0.17 

Установите галочку в ячейке ShadowOn 

Нажмите кнопку ok 

 9. Кликните на иконку  Freeorbit. 

Покрутите изображение, удерживая левую кнопку мыши, затем нажмите 
правую кнопку мыши и нажмите «Exit». 

 

10. Рендерим картинку. 

Вид (View) →Рендеринг (Rendering) →Render. 

Выберите из раскрывающегося списка PhotoRaytracer. 

Установите галочку Shadows. 

Нажмите кнопку Render. 

 

Обмен информацией  между AutoCAD и другими приложениями 
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AutoCAD - это не изолированная система. Существует несколько 
способов работы с другими приложениями: 

- импортировать в AutoCAD файл, созданный в другом приложении; 

- экспортировать файл в формате, который используется другим 
приложением; 

- импортировать растровое изображение, не меняя при этом форматы 
файлов. Растровое изображение (его нужно отличать от векторной 
графики) состоит из точек, которые называются пикселями. А AutoCAD- 
это программа, работающая с векторной графикой; 

- импортировать или экспортировать DXF-файл. Это один из способов 
обмена файлами чертежей между AutoCAD и другими графическими 
программами автоматизации проектирования. 

В AutoCAD можно выполнить экспортирование файлов в другие форматы. 
Экспортирование - это сохранение файла в одном из форматов, отличных 
от «родного». Ниже приведена таблица форматов экспортируемых файлов.  

 

 

Форматы 

 Описание 

WMF Векторный формат, поддерживающий Windows 

ACIS 
Формат файла чертежа системы твердотельного 

моделирования (расширение*.sat) 

STL 
Служит для экспорта только одного объемного объекта, 

который используется в аппаратуре для стереолитографии 

BMP 
Растровый формат изображения, поддерживающийся 

системой Windows 

EPS 
Формат, который используется в некоторых принтерах 

для высококачественной печати текста и изображений 
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DXX 
Extract 

Текстовый файл, содержащий только атрибуты блока 

3DS 
Формат, который используется в пакете 3D Studio фирмы 

AutoDesk 

DXF 
</> 

Текстовый формат чертежей CAD, который 
поддерживается в большинстве СAD-программ. При 
экспортировании можете выбрать любой из DXF-
форматов AutoCAD версий 14,13 и 12. Данный формат 
служит для экспортирования всего чертежа целиком 

DWF Предназначен для помещения чертежа на Web-страничку 

 

Упражнение. Экспортирование файла 

Откройте файл, сохраненный в любом предыдущем упражнении, 
например в упражнении «Вращение изображения модели». 

Выберите команду File→Export (Файл →Экспорт). В 
раскрывающемся списке Saveastype(Тип файла) должна быть выбрана 
опция 3DStudio (*.3ds). В поле имени файла автоматически появится имя 
вашего файла с расширением  .3ds. Щелкните на кнопке «Сохранить». 

Запрос:Selectobjects:(Выберите объекты:)-Сформируйте рамку 
вокруг объекта. ЩелкнитеEnter. 

Появилосьдиалоговоеокно3DStudio File Export Options (рис. 
20).Щелкните ОК.  

Загрузите систему 3D Studio MAX, в меню Fileвыберите 
Importиоткройте созданный файл. 

 

Вопросы для самоконтроля 
 

1. C помощью какой команды можно раскрасить объект?  
2. Какие опции имеет команда Shademode? 
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3. С помощью какой функции можно вращать изображение на экране?  
4. Какие режимы вращения изображения вы знаете?  
5. Как восстановить вид, который был на экране до входа в режим 

вращения?  
6. Какие виды тонированияAutoCAD вы знаете? Чем они отличаются?  
7. Как задать область тонирования?  
8. Как импортировать материал в файл чертежа? 
9. Какие виды фона существуют в AutoCAD? 
10. Какие типы источников света  в AutoCAD вы знаете? 
11. Как экспортировать файл AutoCAD в другую систему? 

 

Практическое задание 
 

Создайте реалистичное изображение (с использованием материалов, 
источников света, фона) рисунка, выполненного в практическом задании к 
практической работе № 1. 

 

Практическая работа № 6 

 
ПЕЧАТЬ ЧЕРТЕЖА 

 

Цель работы 

Приобретение практических навыков в подготовке чертежа к печати и 
выводе его на бумагу. 
 

Порядок выполнения 
 

Практическая работа заключается в последовательной реализации 
нижеследующего интерактивного диалога с системой 
автоматизированного проектирования AutoCAD и выполнении 
индивидуального задания. 
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Подготовка к печати 

Работу с чертежом нельзя считать завершенной до тех пор, пока 
окончательный результат не будет представлен на бумаге. Обычно для 
вывода чертежей используются плоттеры, однако для этого можно при-
менять и обычные принтеры. Существует огромное количество принтеров 
и плоттеров, в которых может использоваться бумага различных форматов 
и размеров.  

После окончания создания чертежа часто необходимо выполнить 
дополнительные операции, например вставить блок основной надписи. 
Даже если этот блок уже создан, может понадобиться ввести в него не-
которые данные, например дату завершения чертежа. Кроме того, следует 
заморозить те слои чертежа, которые не нужно выводить на бумагу. 

Во многих архитектурных и технических чертежах обычно представ-
лено несколько видов модели. В таком случае перед печатью следует 
проверить взаимное расположение этих видов и надписей, а также наличие 
достаточного расстояния между ними. 

Процесс печати в AutoCAD обладает некоторыми особенностями. 
Необходимо помнить, что чертеж можно напечатать как из пространства 
модели, так и из пространства листа. Первый метод пригоден скорее для 
выполнения пробной печати. Если же вам необходимо получить 
соответствующую требованиям конструкторскую документацию, лучше 
применить второй метод: создать вкладку макета для печати на бумаге 
определенного формата и необходимые видовые экраны на этой вкладке, 
установить в них масштаб и произвести печать. 

Внешний вид объекта при выводе на печать может определяться не 
только тем, как он выглядит в окне редактора, но и стилями печати. Стили 
печати группируются в таблицы стилей. AutoCAD поддерживает таблицы 
стилей печати двух типов: цветозависимые и именованные.  

Упражнение. Печать чертежа из пространства модели 

Откройте чертеж в AutoCAD. 
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Рис. 1 

 

Щелкните на вкладке Model (Модель), которая находится в нижней 
части графической зоны. 

Выполните команду  ViewNavigateExtents, чтобы 
обозначить область чертежа, которую вы собираетесь 
печатать. 

Выберите в меню приложения (Application Menu) Print->Plot. 
Появится диалоговое окно Plot (Печать), которое показано на рис. 1. 

В группе Printer/Plotter выберите устройство печати, которое вы 
обычно используете в работе (выбирайте имена системных устройств, 
которые помечены пиктограммой с изображением принтера, на данном 
этапе не следует использовать несистемные устройства, отмеченные 
пиктограммой с изображением плоттера).  
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Все остальные значения параметров группы Printer/Plotter оставьте 
без изменений (см. рис. 1). 

В группе элементов What to plot (Что печатать) установите 
переключатель Current tab (Текущая вкладка). 

Не устанавливайте флажок Plot to file (Печать в файл). 

В группе Paper size (Формат бумаги) выберите тот формат, который 
соответствует бумаге, загруженной в ваш принтер. 

В области Plot area (Область печати) установите переключатель 
Extents (Границы).  

В области Plot area (Область печати)  вы определяете, какую часть 
чертежа нужно распечатать. Возможности, которые при этом 
предоставляются, описаны ниже. 

Limits или Layout (Пределы или Лист) — название этого 
переключателя меняется в зависимости от того, из какой вкладки (Model 
либо Layout) вызвано окно Plot. Если текущей является вкладка Model, как 
в нашем случае, то при выборе данного переключателя будет напечатана 
область, заданная параметром Limits. Если текущей является вкладка 
Layout, печатается макет с установленными параметрами. 

Extents (Границы) — по своему действию переключатель подобен 
команде Zoom Extents. Если он активен, печатаются все объекты чертежа, а 
опция Limits игнорируется.  

Display (Экран) — выбор этого переключателя задает печать 
текущего изображения на экране. При использовании видов печатается 
текущий вид. 

View (Вид) — если вид предварительно сохранен командой View, его 
можно напечатать, выбрав этот переключатель. 

Window (Окно) — воспользовавшись данным переключателем, 
можно распечатать любую часть чертежа, поскольку он позволяет выбрать 
область, подлежащую печати. 

В группе Drawing Orientation (Ориентация страницы) установите 
переключатель Portrait (Книжная) или Landscape (Альбомная). Если длина 
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чертежа превосходит его высоту  — установите переключатель Landscape 
(Альбомная); если же наоборот — установите переключатель Portrait 
(Книжная). 

В группе элементов Plot scale (Масштаб печати), отметьте Fit to 
paper (Вместить на листе). 

Еще одна группа параметров окна Plot  - Plot offset. Принтеры и 
графопостроители не могут наносить изображение возле самых границ 
бумаги. (По этой причине значения в поле Printable area (Область печати) 
не совпадают с размером бумаги.) Вот почему нижний левый угол 
выводимой на печать области чертежа не совпадет с нижним левым углом 
листа бумаги. 

Сместить чертеж относительно бумаги можно путем задания 
положительных или отрицательных значений X и Y. Для 
графопостроителей рабочей позицией является нижний левый угол бумаги 
(альбомная ориентация), а для принтеров — верхний левый угол (книжная 
ориентация). Можно также использовать опцию Center the plot 
(Центрировать чертеж). 

Оставьте для элементов в группах Plot offset (Смешение) и Plot options 
(Параметры печати) значения, установленные по умолчанию (см. рис. 2). 

Флажок Center the plot (Выровнять чертеж по центру) не 
устанавливайте. 

Значения в текстовых полях X и Y (группа элементов Plot Offset 
(Смещение)) оставьте равными 0.00. 

Флажок Plot With Plot Styles (Печатать со стилями печати) оставьте 
установленным. 

Устанавливайте флажок Hide objects (Скрыть объекты), если 
необходимо распечатать чертеж со скрытыми невидимыми линиями. 

Щелкните на кнопке Preview (Полный предварительный просмотр) и 
проверьте, как выглядит ваш чертеж целиком на "листе бумаги" (рис. 4); 
затем щелкните Close Preview Window , чтобы вернуться в диалоговое 
окно Plot (Печать). 

Если в окне предварительного просмотра вы обнаружили какие-либо 
несоответствия тому, что ожидали, исправьте нужный параметр 
(например, в группе элементов Drawing orientation (Ориентация 
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страницы)) и вновь воспользуйтесь возможностью полного 
предварительного просмотра. 

 

Рис. 2 

Компоновки пространства листа 

 

Пространство листа - это отдельное пространство, в котором 
проводится работа над печатной версией чертежа. Система AutoCAD , как 
и AutoCAD ,  позволяет создавать в одном чертеже больше одной 
компоновки (layout) и устанавливать для каждой из таких компоновок 
специфические параметры печати. 

Конструкция, созданная в пространстве модели, отображается на 
вкладке Layout лишь в том случае, если в последней имеется плавающий 
видовой экран (ПВЭ). В пространстве листа можно создать любое 
количество прямоугольных или многоугольных ПВЭ. Сначала в каждом из 
них отображается одна и та же композиция пространства модели, потому 
что в чертеже существует единственное пространство модели. Однако в 
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каждом ПВЭ можно управлять видимостью слоев и масштабом. Это 
позволяет представить на одном листе различные виды конструкции, 
созданной в пространстве модели. Будет ли на новой вкладке Layout 
автоматически создаваться ПВЭ, определяет состояние опции Create 
Viewport in New Layouts (Создавать видовые экраны в новых листах) на 
вкладке Display (Дисплей) окна Options (Опции). См. Рис 3. 

 

Печать в пространстве листа 

Печать в пространстве листа во многом похожа на печать в 
пространстве модели. Исключение состоит в том, что сначала необходимо 
создать компоновку пространства листа и перед тем, как открыть 
диалоговое окно Plot (Печать), активизировать вкладку именно этой 
компоновки. 

Откройте чертеж, который содержит компоновку пространства листа. 

Если под рукой нет подходящих чертежей, воспользуйтесь одним из 
уже готовых файлов, которые поставляются с AutoCAD и  находятся в 
папке \Program Files\AutoCAD \Sample. 

Присутствие вкладки Layout рядом с вкладкой Model (Модель) в 
нижней части графической зоны не является гарантией того, что чертеж 
уже содержит компоновку в пространстве листа. Эта вкладка всегда 
появляется при открытии в AutoCAD  чертежа, созданного в ранних 
версиях программы, а при открытии чертежа, созданного в AutoCAD 2000 
и AutoCAD , появляются даже не одна, а две такие вкладки: Layout1 и 
Layout2. 
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Рис. 3 

Щелкните на первой вкладке, которая находится справа от вкладки 
Model в нижней части графической зоны. 

По умолчанию компоновкам пространства листа присвоены имена 
Layout1 и Layout2, но можно присвоить компоновкам другие имена. 

Не путайте вкладку Model и кнопку MODEL/PAPER (Пространство 
модели/Пространство листа), которая находится в строке состояния 
программы AutoCAD. Активизированной вкладкой (например, Model или 
Layout2) определяется, какой вид чертежа (в пространстве модели или в 
пространстве листа) отображен в графической зоне AutoCAD. Если вы 
печатаете компоновку, то не имеет значения, что в данный момент 
отображено на кнопке MODEL/PAPER -  MODEL или PAPER, - AutoCAD 
всегда печатает компоновку пространства листа. 



 

161 

 

При появлении диалогового окна Page Setup (Параметры страницы), 
щелкните на кнопке Cancel (Отмена) и после того, как окно закроется, 
щелкните на кнопке Undo (Отменить) панели инструментов Standard 
(Стандартная), чтобы вернуться в пространство модели. 

Появление диалогового окна Page Setup для AutoCAD - это способ 
сообщить пользователю о том, что не установлены параметры компоновки 
пространства листа.  

Если диалоговое окно Page Setup не появилось, а появился чертеж, значит, 
можно продолжать настройку печати компоновки. 

 Убедитесь в том, что на кнопке MODEL/PAPER, расположенной в 
строке состояния,  отображена   надпись   PAPER.  Таким образом, теперь 
вы можете быть уверены в том, что на печать будет выведено все 
содержимое компоновки пространства листа, а не только содержимое 
определенного видового экрана пространства модели. 

Начиная с момента «Выполните команду  View->Navigate->Extents, 
чтобы обозначить область чертежа, которую вы собираетесь печатать» 
процедура печати компоновки пространства листа ничем не отличается от 
процедуры печати в пространстве модели. 

 

Печать в масштабе 

 

Создавая чертеж вручную, вы предварительно определяете его 
масштаб (отношение реального размера объекта к его размеру на бумаге). 
Затем выполняете чертеж в этом масштабе, то есть пропорционально 
увеличиваете или уменьшаете размеры реального объекта при размещении 
на бумаге. 

В AutoCAD объект чертится с использованием его действительных 
размеров. И только при печати на бумаге определенного формата чертеж 
масштабируют, чтобы он поместился на листе. Для того чтобы чертеж 
хорошо масштабировался при выводе на печать, при его начальной 
настройке, определяя параметр Limits в пространстве модели, необходимо 
учесть формат бумаги и масштаб чертежа. Масштаб печати равен 
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отношению формата бумаги к параметру Limits и является величиной, 
обратной коэффициенту масштабирования чертежа. Например, если вы 
хотите начертить объект длиной 600 мм и распечатать его на бумаге 
формата 420×297, то можете задать параметр Limits пространства модели 
равным 840,594 (удвоенный размер формата бумаги). В этом случае 
коэффициент масштабирования чертежа равен 2, а в окне Plot  в поле со 
списком Scale (Масштаб) необходимо выбрать масштаб 1:2. 

Правильно вычислить параметр Limits и коэффициент масштабирования 
чертежа легче, если вы знаете размеры стандартных форматов бумаги. 

Формат          А4           A3           А2            А1            АО 

Размер, мм    210×297   297×420   420×594    594×841    841×1189 

 

Scale (Масштаб) - этот список предоставляет две возможности: 
масштабировать чертеж так, чтобы он заполнил весь лист, либо указать 
требуемый масштаб. В первом случае нужно выбрать в списке элемент Fit 
to paper (Подогнать по размеру бумаги). Список также включает масштабы 
из стандартного ряда. В случае отсутствия в списке нужного вам масштаба 
воспользуйтесь полем ввода Custom (Специальный), где можно задавать 
целые числа и десятичные дроби. 

Scale Lineweights (Масштабировать толщину линии) - с помощью 
этой опции масштабируют толщину линий чертежа. Если опция активна, 
толщина линий при печати пропорциональна масштабу чертежа 
(например, линия толщиной 1 мм при выборе масштаба 1:2 будет 
начерчена пером толщиной 0.5 мм). В противном случае (по умолчанию) 
масштаб на толщину линий не влияет. 

Даже если ваши чертежи рассчитаны на печать в определенном 
масштабе, параметр печати Fit to paper (Подогнать по размеру бумаги), 
чаще всего является наиболее эффективным способом создания пробного 
чертежа уменьшенного размера.  

 

Вопросы для самоконтроля 
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1. В каких случаях производится печать из пространства модели, а в 
каких – из пространства листа? 

2. Чем определяется внешний вид объекта при выводе на печать?  

3. Какие параметры устанавливаются на вкладке Plot Device 
диалогового окна Plot? 

4. Какие параметры устанавливаются на вкладке Plot Settings 
диалогового окна Plot? 

5. Что определяется в области Plot area и какие возможности при 
этом предоставляются,? 

6. Где устанавливается масштаб печати? 
7. Как сместить чертеж относительно бумаги? 
8. Как осуществить полный предварительный просмотр? 
9. Чем отличается печать из пространства модели от печати из 

пространства листа? 
10.  Что определяется активизированной вкладкой (например, Model 

или Layout2)? 
11.  Как напечатать чертеж в масштабе? 
12.  Как правильно рассчитать масштаб печати? 
13.  Как масштабировать толщину линии? 
14.  Какой существует наиболее эффективный способ создания 

пробного чертежа уменьшенного размера? 
 

 

Практическое задание 
 

Выполните печать готовых чертежей из пространства модели, из 
пространства листа, печать в масштабе. 
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ЗАКЛЮЧЕНИЕ 

 
В наше время изображения, созданные на компьютере, окружают нас 

повсеместно: на телевидении, в кино, на страницах газет и журналов. 
Графические технологии используется практически во всех научных и 
инженерных дисциплинах для наглядности восприятия и передачи 
информации. Уже более четверти века компания Autodesk занимается 
разработкой эффективных систем автоматизированного проектирования. 
Используемый миллионами специалистов во всем мире, AutoCAD 
постоянно совершенствуется, чтобы идти в ногу со временем. 
Эффективные средства подготовки документации позволяют выполнять 
все этапы работы над проектом — от разработки концепции до 
завершающей стадии. Средства автоматизации, управления данными и 
редактирования сводят к минимуму объем повторяющихся задач и 
экономят время. 

Получив общее представление о способах трехмерного 
моделирования объектов в системе AutoCAD, можно переходить к 
рассмотрению тех возможностей машинной графики, благодаря которым 
создаются фотореалистичные или почти фотореалистичные изображения 
сцен.  

Авторы полагают, что студенты, изучившие предложенный 
материал, приобрели необходимые знания, которые послужат базой для 
дальнейшего, уже самостоятельного, повышения квалификации в данном 
направлении. 
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